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System Requirements 
 
UN-SCAN-IT gel runs on IBM PC or 100% compatible computers with: 
  
   • Windows XP, Vista, Windows 7, Windows 8, Windows 10 (or newer) 
   • 256 MB or more of RAM memory 
   • 20 MB of free hard disk space 
   • Mouse (or compatible) pointing device 
   • Color graphics monitor at 800 x 600 resolution (or higher) 
   • Scanner, digital camera, other imaging device, or standard image files 
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INTRODUCTION 
 
This Setup and User's Manual describes the installation and use of your 
UN-SCAN-IT gel – Gel Analysis Software. Chapter 1 provides information 
on the installation of the UN-SCAN-IT gel software. Chapter 2 describes 
some useful methods for scanning and saving your gel and graphical images. 
Chapter 3 describes how to start the UN-SCAN-IT gel program on your 
computer. 
 
The remaining chapters will introduce the UN-SCAN-IT gel software step by 
step and familiarize you with the features of the UN-SCAN-IT gel – Gel 
Analysis Software. This software was written by scientists, and is intended to 
be very intuitive, and almost entirely menu driven. In addition, context 
sensitive help buttons and menus are available throughout most of the gel 
analysis and graph digitizing portions of the software. It is recommended that 
the first time user consult the manual to become familiar with all of the 
features of the UN-SCAN-IT gel software. 
 
This manual contains a glossary to explain some of the analysis and digitizing 
terms used throughout this manual, and a troubleshooting section (Appendix 
B and Appendix C) to help with some of the most commonly encountered 
questions. Previous users of the UN-SCAN-IT gel software may also wish to 
refer to Appendix D and Appendix E, which list some of the newest features 
available with this version. 
 
If you have difficulty obtaining or digitizing your own images, you may wish 
to practice on the sample images that are automatically installed into the 
UN-SCAN-IT gel folder. These sample images will assist you in setting up 
and analyzing an image for the first time. If you have further questions or 
need assistance, please contact customer support: 
 
 
Customer Support (USA): 
 Tel: 1-801-377-6978 
 FAX: 1-801-228-2448 
 E-Mail: info@silkscientific.com 
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Gel Analysis 
 
The UN-SCAN-IT gel software acts like a densitometer to analyze gel-type 
images (electrophoresis gels, TLC plates, etc.) and extract quantitative data 
from the images. The software requires the image to be input in a standard 
image format that can be obtained from a scanner, digital camera, the internet, 
etc.. The image should be obtained at an appropriate resolution, as the 
software will extract the image data at Full Scanner Resolution. 
UN-SCAN-IT gel can be used to estimate band densities, relative mobilities, 
concentrations, and molecular weights for each band. The data can then be 
exported into almost any spreadsheet, data analysis, or graphics program. 
 
When scanning gel images, the image should generally be scanned and saved 
in 8-bit grayscale (256 grayscale) format (although color images are also 
supported). Most scanners and digital cameras include software that allow the 
image to be  saved in an 8-bit grayscale format. 
 
 
Graph Digitizing 
 
The UN-SCAN-IT gel software can also be used to convert hard copy graphs 
and graphical images  to digital (x,y) data. The graph must be available in a 
standard image format that can be obtained from a scanner or similar image 
input device (such as a digital camera). The image should be obtained at an 
appropriate resolution, as the UN-SCAN-IT gel software will extract the 
underlying (x,y) data at Full Scanner Resolution. The data can be digitized 
using automatic or manual modes, and the digitized data can be exported into 
almost any spreadsheet, data analysis, or graphics program. 
 
 
Image and Data Formats 
 
UN-SCAN-IT gel accepts a large number of different image file formats from 
scanners, image input devices, and standard image files. The images should be 
saved in one of the following formats: 
 
 TIFF (.tif, tiff) 
 JPG (.jpg, jpeg) 
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 Windows Bitmap (.bmp) 
 PNG (.png) 
 Gif (.gif) 
 PCX/DCX (.pcx, dcx) 
 Targa (.tga) 
 Windows Metafile (.wmf) 
 
The supported image formats are listed in the Open Image File dialog box 
when loading an image to be analyzed. 
  
Throughout this manual we will be giving instructions that include key 
sequences or menu selections that should be directly input into the computer. 
Specific items that should be typed or selected will be indicated in Bold. In 
addition we will refer to the mouse buttons as Left and Right, where Left is 
referring to the primary mouse button, while Right is referring to the 
secondary mouse button. 
 
Although UN-SCAN-IT gel has many graphics and other auxiliary data 
options, it should be noted that the digitized data can be easily exported to 
almost any other commercial software program that accepts (x,y) ASCII Text 
data. The data can be exported by saving the digitized (x,y) data in ASCII text 
format, or by copying the data to the Clipboard and pasting the data directly 
into another software package. Although this manual uses the general term 
ASCII to refer to the standard data format for the digitized data, this format is 
also often referred to as TEXT (.txt) format. 
 
 
Crosshair Magnification Window 
 
The UN-SCAN-IT analysis and digitizing screens contain a crosshair 
magnification window (in the upper right corner), which displays a full 
scanner resolution view of the region surrounding the crosshair. This view 
should be used to obtain precise alignment of the crosshair when positioning 
interacting with the main image. 
  
Accuracy 
 
The UN-SCAN-IT gel software program is designed as a general tool for 
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extracting data from images. As with any tool, the accuracy of the results 
can be largely dependent upon how that tool is used. The accuracy of the 
data is not only a function of the software, but is also dependent upon the 
original conditions of the experiment, the quality of the image, as well as 
the set-up processes and interaction performed by the user. Additional 
inherent limitations exist in converting image information to digital data, 
and thus the accuracy and precision of the data should not be assumed by 
the user. Silk Scientific makes no representation or warranties with respect 
to the absolute accuracy of the data or the fitness for any particular purpose. 
Please contact us if you have any questions regarding the accuracy of the 
results obtained using this product. 
 
License Information 
This program may not be networked or otherwise installed or used on more 
than one computer or computer terminal at the same time (unless a site 
license has been obtained directly from Silk Scientific). The software is 
owned by Silk Scientific Corp. and is protected by the applicable United 
States and International copyright laws. Any printed materials 
accompanying the software are also copyrighted, and may not be copied. 
Silk Scientific's entire liability shall be repair or replacement of the software 
properly returned to Silk Scientific. Silk Scientific disclaims all implied 
warranties of accuracy or fitness for a particular purpose, and shall not be 
liable for damages from loss of business profits or related income or other 
related damages resulting from the accuracy, use of, or inability to use this 
product. 
 
 
Crosshair Movement 
 
When digitizing (x,y) images, the crosshair used in the digitizing screens can 
be positioned using the mouse or keyboard arrow keys. Fine movements can 
be achieved using the keyboard arrow keys, while larger movements can be 
made by pressing the Ctrl + arrow keys. In addition, you may occasionally 
wish to restrict the crosshair movement to purely vertical or horizontal 
directions, which can be accomplished using the arrow keys (rather than the 
mouse). 

iv  UN-SCAN-IT gel User’s Manual 



 

 Chapter 1 
 
 SOFTWARE INSTALLATION 
 
 
1.1  Overview 
 
The UN-SCAN-IT gel software should be installed in the Program Files 
folder on your hard drive. The UN-SCAN-IT gel Setup program setup.exe 
should be used to install the required  files to your hard drive. The 
UN-SCAN-IT gel files have been compressed, and will not run properly if 
you simply copy the files to the hard drive or transfer the files from another 
computer without using the Setup program. 
  
 
1.2  .NET Framework 
 
The UN-SCAN-IT gel software requires the standard Microsoft .NET 4.0 (or 
higher) Framework to be present on the computer where the software resides. 
Most current Windows XP, Windows Vista, Windows 7, Windows 8, and 
Windows 10 (or newer) systems will already have the .NET 4.0 Framework 
installed with the operating system. If this Framework is not present on the 
computer, the UN-SCAN-IT gel installation program will prompt the user to 
install the .NET 4.0 Framework. 
 
 
1.3  Write Privileges 
 
The UN-SCAN-IT gel software installation requires the current user to have 
write privileges when installing the software. 
 
 
1.4  Installing UN-SCAN-IT gel on the Hard Disk 
 
(1)  Insert the UN-SCAN-IT gel CD into your computers CD drive. 
 
(2)  The installation program should run automatically, or you can select 
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Run... from the Windows Start menu. 
 
  Type D:\setup.exe (if CD drive is D:) and select OK. 
   
(3)  Follow the on-screen instructions until UN-SCAN-IT gel has been 

installed. The software will notify you when the installation is complete. 
 
(4)  Finalize Installation: With the UN-SCAN-IT gel CD in your computer’s 

CD drive, start the UN-SCAN-IT gel software from the desktop icon or 
programs menu. If you do not have the original UN-SCAN-IT CD, or 
your computer does not recognize the CD, select the ‘Bypass CD’ option 
and follow the instructions. 

 
The first time the UN-SCAN-IT gel software is run on your computer, you 
will be prompted to enter the Serial Number and Registration Number 
associated with your license (these numbers are generally located on the 
inside cover of the User’s Manual). Once the registration process is complete, 
remove the UN-SCAN-IT gel CD and store in a safe place. 

2  UN-SCAN-IT gel User’s Manual 



 

 Chapter 2 
 
 
 OBTAINING THE IMAGE 
 
 
2.1  Overview 
 
Although the name of this software UN-SCAN-IT gel, the image does not 
need to come directly from a scanner. The UN-SCAN-IT gel software can 
analyze almost any standard image format, and the image can come from a 
variety of sources (scanners, digital cameras, downloaded internet images, 
etc.). For simplicity, this chapter will give some guidelines for obtaining an 
image using a standard flat bed scanner. Virtually all scanners include their 
own scanning and image editing software. Before using UN-SCAN-IT gel, 
we recommend that you simply use the software that was included with your 
scanner to scan, edit, and save the image in a standard image format. 
 
UN-SCAN-IT gel can directly import image files and analyze these images at 
full scanner resolution. In addition, if there is an image that can be displayed 
on your Windows computer screen, the image can be saved to the Windows 
clipboard by pressing the Alt + Print Screen keys, and the image can be 
converted to a file using the Windows Paintbrush or a similar program’s Paste 
option (this method of creating files is limited to screen resolution). 
 
 
2.2  Scanner Operation 
 
There are a large variety of affordable scanner types and models currently 
available. Virtually all of these scanners can easily produce images of 
sufficient quality for accurate digitizing. 
 
Gel Images 
 
We recommend that gel images generally be scanned and saved in 8-bit 
grayscale format (although the software does also support color images). 
Scanning in line art format results in a loss of information, and scanning in 
color format often requires additional computer memory without increasing 
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the amount of useful information.  
Caution! Images from hard copy publications (e.g. journal articles) are 
generally printed with dithered dots, and do not actually contain the true 
intensity values of the gel bands. Extreme cautions should be used exercised 
in analyzing dithered images. 
  
Graphical Images 
 
The UN-SCAN-IT gel software can digitize color, grayscale, and black & 
white (line art) images. Color images are often most useful for distinguishing 
between lines or different colors; grayscale images of often best for graphs 
that contain background grid lines that are a lighter shade than the data line; 
and black & white (line-art) images are generally best for digitizing standard 
black & white graphs that simply contain a dark data line on a white 
background. 
 
For details regarding the actual use of your scanner and scanning software, 
refer to the User's Manual for your particular scanner and scanning software. 
Being familiar with your scanning software will help produce higher quality 
images and improve the analysis results obtained using the UN-SCAN-IT gel 
software.. 
 
 
2.3  Original Size 
 
Although UN-SCAN-IT gel can digitize images of virtually any size, 
scanning large originals can present significant difficulties. Generally, the gel 
or graph should be of such size as to be easily scanned by your scanner 
(usually on 8½” x 11” paper or smaller). Some suggestions for dealing with 
larger originals include photo reducing the original, making use of a larger 
scanner, or using a digital camera. 
 
Long (x,y) Graphs - To digitize long strip chart or recorder output it may be 
necessary to photo reduce the original, or divide the chart into scanning 
regions of more reasonable dimensions (e.g. 8” x 10” or smaller), as most 
scanners will not scan images larger than about 12” to 14”. In this situation, 
scaling marks should be included on each portion of the image being scanned 
in order to insure continuity. 
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2.4  Scanning the Image 
 
Many scanners have several possible ‘image mode’ settings. These settings 
are generally a selectable option contained within the scanning software. 
 
Gels - The preferred mode for scanning most gel images in 8-bit grayscale in 
standard reflective mode. When scanning films or transparencies, scanners 
with a transparency mode can be useful in transmitting additional light 
through the film, thus producing a higher quality image. Although 8-bit 
grayscale images generally provide the best results, color images can also be 
digitized.  
 
(x,y) Graphs - The preferred mode for scanning and digitizing most standard 
graphs is the black & white - line art mode (this mode is also referred to as 
1-bit or black & white drawing). Although black & white images generally 
provide the sharpest images, color and grayscale images can also be useful for 
distinguishing colored data lines or filtering grid lines. 
 
There are multiple resolution settings available with most scanners. Under 
normal circumstances UN-SCAN-IT gel analyzes the image in units of one 
scanner unit resolution. Therefore a scanner setting somewhere between 150 
to 600 dpi is generally sufficient to obtain good results for most images. You 
may wish to experiment with different scanning resolutions to determine 
which setting is most appropriate for your needs. Please note that increasing 
the scanner resolution may result in significantly larger files (e.g. a 600 dpi 
image takes 4 times the memory of a 300 dpi image). 
 
Graph Contrast - When scanning graphical images, the scanner contrast 
control should be set in such a manner as to produce an image that contains a 
dark continuous data line (or data points), while producing a relatively clean 
white (i.e. minimum stray dark pixels) background. 
                  
 
2.5  Straight Scanning 
 
It is recommended that the gel or graph be scanned into the computer as 
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straight as possible. This can generally be accomplished by simply making 
sure the edges of the paper are parallel to the edge of the scanner bed. 
 
If the image is skewed, most scanning software has a 'deskew' feature that 
allows the user to straighten the image (see your User's Manual for your 
particular scanning software). The deskew feature is only useful if the image 
is evenly skewed and has no unevenly skewed (waved) regions. Particular 
caution should be used when scanning an image from a book or technical 
journal, as uneven skewing may occur near the binding region of the image. 
 
 
2.6  Using a Digital Camera 
 
Consult the user’s manual for your specific camera regarding instructions on 
how to obtain, store, and download your images. The images should be saved 
in a standard image format (JPG, TIF, etc.), and not in a proprietary format 
unique to your camera. 
 
 
2.7  Scan 
 
Now you are ready to scan/acquire the image. Consult the User's Manual for 
your particular scanning software for details on scanning images. 
 
 
2.8  Rotating the Image  
 
In order for UN-SCAN-IT to properly analyze the image, the image must be 
displayed ‘right side up’ on the screen before the image is saved. Virtually all 
scanning software has image rotation capabilities (consult your scanning 
software User's Manual for details on such features as Rotate Clockwise and 
Rotate Counterclockwise), thus the image can easily be rotated to the proper 
orientation. 
 
 
2.9  Saving the Image  
 
Once the image has been satisfactorily scanned (re-scan the image if it is too 
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light, dark, waved, etc.), the image should be saved in a standard image 
format so that it can be imported into UN-SCAN-IT gel. Acceptable image 
formats include, but are not limited to: 
 
 TIFF (.tif, tiff) 
 JPG (.jpg, jpeg) 
 Windows Bitmap (.bmp) 
 PNG (.png) 
 Gif (.gif) 
 PCX/DCX (.pcx, dcx) 
 Targa (.tga) 
 Windows Metafile (.wmf) 
 
The scanning software may also allow you to select the image file color type 
when saving the image (e.g. line art, 8-bit grayscale, 24-bit color, etc.). Gel 
images should generally be saved as 8-bit grayscale, while graphical images 
should generally be saved as black & white - line art (color mode can 
occasionally be useful for certain types of images). The image format options 
are often contained in the Save As or Export menu options. See the User's 
Manual for your particular scanner for details on saving image files.  
 
If you have images that have already been saved in image formats other than 
those accepted by UN-SCAN-IT gel, you may be able to read the image into 
your scanning software, and convert the image to a format compatible with 
UN-SCAN-IT gel. 
 
Note: UN-SCAN-IT gel does not currently accept PDF files. PDF files often 
contain multiple pages, imbedded text, and variable dpi settings, which can 
present difficulties in extracting accurate and useful digitized data. The 
PDF file should be converted to a standard image format listed above. 
 
 
2.10  Removing Grid Lines from Graphs | Graphs 
 
Grid lines can present a difficult problem, as they overlap the data lines in 
numerous locations, and can interfere with the automatic line following 
process. Although UN-SCAN-IT gel has features for filtering grid lines 
during the digitizing process, it may be easier to simply reduce or remove the 
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grid lines during the scanning process. The scanner contrast control setting 
can often be used to filter out the lighter and thinner grid lines, while 
continuing to register the darker data lines. By experimenting with this 
contrast adjustment, it may be possible to completely remove the grid lines 
from the image. If the graphical data is currently being collected by an (x,y) 
recorder, it may be possible to turn over the grid paper and digitize the data 
recording on the side that has no grid lines.  

In addition, the UN-SCAN-IT gel software has three types of grid line filters 
available. One of the grid line filters uses the assumption that the grid lines are 
a lighter color/shade than the data line (to use this filter the image must be 
scanned in grayscale mode). The second filter uses the assumption that the 
grid lines are thinner than the data line. The third grid line filter uses the 
assumption that the grid lines run in a truly horizontal and vertical direction. 
These grid line filters are discussed later in this User's Manual. 

 
 
 
If you are unable to remove the grid lines during the scanning process or the 
graph is not suitable for using the UN-SCAN-IT gel grid line filters, most 
scanners do have graphic editing tools (i.e. paintbrushes of various sizes), and 
these tools can be used to erase the grid lines where they intersect the data 
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line. The UN-SCAN-IT gel software does have the option to simply follow 
along the top (or bottom) surface of the data line, therefore, you only need to 
erase the grid lines in the region slightly above (or below) the data line. 
 
 

 
 
As an additional option for overcoming grid line difficulties can be to use the 
UN-SCAN-IT gel Manual Mode (similar to a digitizing tablet). In this mode, 
the crosshair can automatically increment along the X-axis while the user 
controls the Y-axis movement with the keyboard arrow keys or mouse. 
 
 
2.11  Maximizing the Resolution of the Image | Graphs 
 
When digitizing image files with the UN-SCAN-IT gel software, the 
resolution will generally be the same as the original resolution at which the 
image was scanned. Therefore, a 10-inch long graph scanned at 300 dpi will 
yield approximately 3,000 data points. Although some scanners operate at up 
to 1200 dots per inch (dpi) or higher, scanning graphs at these very high 
resolutions will generally not improve the quality of the data, because the 
resolution of the original graph is rarely above 300 dpi. In addition, scanning 
images at extremely high resolutions requires significantly more computer 
memory, disk space, and time (e.g. a 600 dpi image takes 4 times the memory 
of a 300 dpi image). Generally 100 to 300 dpi images are of sufficient 
resolution to provide excellent digitizing results, although you may wish to 
experiment with different scanning resolutions to determine which setting is 
most appropriate for your needs. 
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2.12  Maximizing the Resolution of Digitized Data | Graphs 
 
Although the true optical resolution of the digitized (x,y) data from graphs is 
limited by the dpi resolution of the original image, the digitized data 
resolution can be further enhanced. By selecting the Adjust X Data Spacing 
option available in the Graphing portion of the UN-SCAN-IT gel software, a 
cubic spline (or linear) fit of the data can be used to increase or decrease the 
number of data points, by adjusting the X data spacing to user defined 
increments. 
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 Chapter 3 
 
 RUNNING UN-SCAN-IT GEL 
 
 
3.1  Overview 
 
This chapter describes how to start the UN-SCAN-IT gel program on your 
computer. Before the UN-SCAN-IT gel software can be used to analyze an 
image, the image file should have already been obtained from a scanner, 
digital camera, internet image, etc. (see previous chapter for details). 
 
 
3.2  Running UN-SCAN-IT gel 
 
The easiest way to run UN-SCAN-IT gel is by simply double clicking the 
desktop icon that was created when the software was installed. You can also 
use the Programs option from the Windows Start menu, or you can open the 
UN-SCAN-IT gel folder and double click on the UN-SCAN-IT gel icon. The 
name of the UN-SCAN-IT gel executable file is unscanit.exe, and the folder 
location and name were selected during installation. 
 
 
3.3  UN-SCAN-IT gel Registration Information 
 
The first time the UN-SCAN-IT gel software is started; you should have the 
original UN-SCAN-IT gel CD in your computer’s CD drive. If you do not 
have the CD, or your computer does not recognize the CD, select the ‘Bypass 
CD’ option and follow the instructions. 
 
You will be prompted to enter Serial Number, Registration Number and User 
Name for your UN-SCAN-IT gel software license. The Serial Number and 
Registration Number are generally located on the inside front cover of the 
UN-SCAN-IT gel User's Manual (upgrades may contain the Serial and 
Registration Numbers on the front page of the User’s Manual). You can enter 
whatever User Name you would like displayed. The UN-SCAN-IT gel 
software license is generally restricted to installation on one single computer 
terminal (unless multiple licenses or a site has been obtained). 
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Please return the Owner Registration card that is located in the front of the 
User's Manual, so that we may make you aware of any future product 
upgrades and assist you in your customer support needs. The 
UN-SCAN-IT gel software can also be registered online at 
www.silkscientific.com/contact. 
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 Chapter 4 
 
 FILE OPTIONS 
 
 
4.1  Overview 
 
This chapter will guide you through the different File options present in the 
UN-SCAN-IT gel software. Some of these file menu options can also be 
accessed from the toolbar located below the menus. 
 
Most of the File options will only be available after your image has been 
digitized. See Analyzing Gels or Digitizing (x,y) Graphs chapter. 
 
 
4.2  Main Menu 
 
To enter the File portion of the UN-SCAN-IT gel program from the main 
menu, select: 
 
 File 
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4.3  Paste (x,y) Data from Clipboard 
 
Select Paste (x,y) Data from Clipboard… to paste the contents of the 
Windows clipboard into the UN-SCAN-IT gel program. The data must be in a 
standard (x,y) column format with no text labels in order to be pasted properly 
into UN-SCAN-IT gel. Using this command clears whatever (x,y) data may 
currently be in memory, so you may wish to save your data before using this 
function. . This option does not paste gel data. 
 
 
4.4  Load (x,y) Data 
 
Select Load (x,y) Data… to load a previously digitized (x,y) data file into 
UN-SCAN-IT gel. Do not use this option to load an image file for analysis. 
The standard Windows file dialog box will appear. Loading a file erases all 
digitized data presently in memory, so you may wish to save your data before 
loading data. This software can load (x,y) data saved by UN-SCAN-IT gel, or 
standard comma or tab delimited (x,y) ASCII Text data saved by other 
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programs. This option does not load digitized gel data. 
 
 
4.5  View Data Values 
 
Select View Data Values… to view the current digitized data values. Use the 
scroll bar to move up or down within the digitized data file. 
zed data file. 
 
 
4.6  Adjust X Data Spacing 
 
The (x,y) graph digitizing process converts scanner pixel units into user 
defined scaled units. The resulting X data spacing may appear arbitrary as a 
result of this conversion. However, the X data spacing can be adjusted by 
fitting the digitized (x,y) data points using a cubic spline or linear fit. The X 
Data Spacing can be adjusted in the Graphing / Modifying (x,y) Data 
screen. This option does apply to gel data. 
 
 
4.7  Copy Data to Clipboard 
 
Select Copy Data to Clipboard... to copy all or part of the data values to the 
Clipboard. The data can then be pasted into other programs. Use the scroll bar 
to move up or down within the data file. Drag the mouse (or hold down the 
shift key) to highlight the data, and then select Copy (all of the data can be 
selected by clicking on the row column heading or by pressing Ctrl+A).  
 
 
4.8  Save Data 
 
Select Save Data… to save the data to a file. The data can be saved in tab or 
comma delimited ASCII Text format. 
 
To export the data into other spreadsheet or graphics programs, save the data 
in ASCII Text format with the appropriate file extension if required (e.g. 
sample.txt, sample.dat, sample.csv, etc.). Often the File Open dialog box for 
these programs will only display specific file types (e.g. .xls for Excel), 
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however, other files can be displayed by selecting All Files *.* from the File 
Type drop down menu. Once the data have been imported by the other 
spreadsheet or programs, you can then use all of the features associated with 
that software to analyze, modify, or graph the data. 
 
 
4.9  Clear Data 
 
Select Clear Data to clear all the data values from memory. In order to 
prevent accidental clearing of data, you will be prompted to confirm the Clear 
Data command. 
 
Graph Digitizing - The Clear Data command does not erase the graph 
digitizing settings, thus you may select Return to Current (x,y) Image from 
the Digitize Graph menu to continue digitizing the current graph image. 
When digitizing graphs, the Clear Data feature can be used to digitize 
multiple curves on a graph by digitizing each curve, saving the data, clearing 
the data, then returning to the current image to digitize the next curve. 
 
 
4.10  Print Data 
 
Select Print Data… to print the data values. If you have any difficulties 
printing the data, save the data in ASCII Text format (or copy to the data to 
the clipboard), and export the data into your word processor or spreadsheet 
program for printing. 
 
 
4.11  Restore All Default Settings 
 
Select Restore All Default Settings to restore all of the UN-SCAN-IT gel 
settings to their original values when the software was first installed. This 
feature can be useful for restoring Window sizes, default colors, and default 
analysis settings. 
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4.12  Scan / Modify Image  
 
See Appendix A. 
 
 
4.13  Exit 
 
Select Exit to exit the UN-SCAN-IT gel software. You will be prompted to 
save any new data before exiting. 
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 Chapter 5 
 
 ANALYZING GELS 
 
 
5.1  Overview 
 
This chapter will guide you through the analysis process for a gel image and 
explore the options available in the UN-SCAN-IT gel software. In this chapter 
you will be instructed to draw lane or segment boxes on the gel image, and 
this can generally be accomplished using the mouse and the left mouse button. 
Some of the options described in this chapter may not be encountered in every 
analysis session. 
 
UN-SCAN-IT gel is designed as a general tool for extracting data from 
images. As with any tool, the accuracy of the results can be largely dependent 
upon how that tool is used. The accuracy of the data is not only a function of 
the UN-SCAN-IT gel software, but is also dependent upon the original 
conditions of the experiment, the quality of the image, as well as the set-up 
processes and interaction performed by the user. Inherent limitations exist in 
converting image information to digital data, and thus the accuracy and 
precision of the data should not be assumed by the user. Please contact Silk 
Scientific if you have any questions regarding the accuracy of the results 
obtained using this product. 
 
 
5.2  Main Menu 
 
To enter the gel analysis portion of the UN-SCAN-IT gel program from the 
main menu, select: 
 
 Analyze Gel 
 
Analyze Gel Image - main menu 
 
Select Analyze Gel Image… to analyze a gel, TLC, dot blot, etc. image that 
was saved in a compatible image format. 
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5.3  Open Image File 
 
If Analyze Gel Image… was selected from the main menu, then a file dialog 
box will appear (only acceptable image files with the appropriate file 
extensions will appear in the list of files that can be selected). Select the gel 
image to analyze. 
 
 
5.4  Gel Analysis Mode 
 
The Gel Analysis Mode allows you to select the type of analysis that you wish 
to perform for the image. 
 

 Lane Analysis - Select this mode to obtain a 
density profile and band analysis for one or more 
vertical gel lanes or gel sequences. Each lane can 
contain either a single band or multiple bands. 
For each lane, the software sums all of the pixel 
intensities in each horizontal row of the lane, and 
these summed values for each row represent an 

(x,y) value in the density profile for that lane. The software then automatically 
finds the peaks in that density profile that correspond to each band. Additional 
peaks can be added or deleted from the density profile, and the background 
lines can be dragged and adjusted. The pixel sums (above the background 
level) are then calculated for each band. When the band calculations for all the 
lanes have been completed, the digitized band values and parameters are 
displayed in a spreadsheet format below the gel image. The gel data can be 
exported into a spreadsheet or other data analysis software. 
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 Segment Analysis - Select this mode to sum all 
of the pixel intensities within a band and perform 
a band analysis on one or more bands. The pixel 
intensities can be corrected for background by 
using one of several background correction 
methods within the software. The pixel sums 
(with any background corrections) are then 

calculated for each band. When the calculations for all the bands have been 
completed, the digitized band values and parameters are displayed in a 
spreadsheet format below the gel image. The gel data can be exported into a 
spreadsheet or other data analysis software. 
 
 

 Dot Blot Analysis - Select this mode to sum all 
of the pixel intensities within a circular/elliptical 
blot region and perform an analysis on one or 
more blots in a dot blot array. The pixel 
intensities can be corrected for background by 
using one of several background correction 
methods within the software. The pixel sums 

(with any background corrections) are then calculated for each blot. When the 
calculations for all the blots have been completed, the digitized blot values 
and parameters are displayed in a spreadsheet format below the dot blot 
image. The dot blot data can be exported into a spreadsheet or other data 
analysis software. 
 
 
Positive/Negative - gel analysis mode 
 
Select Positive for images where there are dark bands on a light background.  
Select Negative for images where there are light bands on a dark background. 
 
 
5.5  Gel Analysis Options 
 
The Gel Analysis Options allows you to select from the available 
UN-SCAN-IT gel analysis options for the image you will be analyzing. Only 
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the options that are associated with the Gel Analysis Mode selected will be 
displayed. 
 
 
Main Image View – gel analysis options  
 
Maintain Aspect Ratio: This method maintains the original image aspect 
ratio in the main image viewing area. Although the image may not fill the 
entire viewing area, the image can be zoomed (1x, 2x, 4x, 8x, and 100%) to 
increase or adjust the size of the image within the viewing area. The zoom 
feature allows a closer inspection of the positioning of the lane and segment 
boxes. Note: The analysis may be slower while image is zoomed. 
 
Stretch to Fit: This method stretches the image to fill the entire main 
viewing window, making full use of the entire image viewing area. 
Although this method may cause some images to appear distorted, the 
actual digitized data values will not be affected by the stretching. 
 
 
Color Mode - gel analysis options  
 
This option allows you to select the type of color differentiation 
UN-SCAN-IT gel will use to determine the intensity of the bands. 
 
Grayscale Intensity - This method is for analyzing grayscale images by 
assigning a grayscale value between 0 (least intense) and 255 (most intense) 
for each pixel in the image. Most gel images should be scanned, saved, and 
analyzed in grayscale mode. Color information is rarely useful for 
distinguishing bands, and can potentially be difficult to analyze accurately. 
 
HSB Color Intensity - This method is for analyzing color images by 
assigning an intensity value between 0 (least intense) and 255 (most intense) 
only for pixels of a similar color hue. The Single Color Hue Range value 
determines the color range that will be accepted and analyzed as data when 
using the HSB method. 
(0 = Small color range : 100 = Large color range)." 
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Background Correction - gel analysis options  
 
This option allows you to select the type of background correction that will be 
applied to the gel image being analyzed. 
 
Density Profile Baseline Subtraction (Lanes Mode) - This mode uses the 
local minima values at the edge of each band's density profile as background. 
This method generally requires no additional background correction. 
 
No Background Correction (Segments/Dot Blots Mode) - This mode 
accepts the intensity value of each pixel without modification. If the 
background is not zero (white or black), then a background correction should 
be used.  
 
Subtract Single Region Background Value – This mode subtracts a single 
user defined background value from all pixels. 
 
Subtract Upper and Lower Edge Interpolation – This mode subtracts an 
interpolated value from each pixel based upon the background value assigned 
at the upper and lower edge of each lane or segment box. 
 
Subtract Four Corners Interpolation – This mode subtracts an interpolated 
value from each pixel based upon the background value assigned at the four 
corners of each lane or segment box. 
 
Calibrate Image Background – This mode stretches the low end of the pixel 
spectrum to force the background to zero. 
 
Calibrate Overall Image – This mode stretches the entire pixel spectrum to 
approximate multiple user defined pixel values. 
 
Load Previous Image Calibration – This feature loads the image calibration 
values saved from a previous background or overall image calibration session. 
 
 
Optical Intensity Calculation - gel analysis options  
 
This option allows you to select the optical intensity calculation mode based 
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on the method that was used to obtain the image. 
  
Linear – Standard Reflective Scan - Use this method for images that were 
scanned in standard reflective mode. Most scanners and digital cameras 
operate in reflective mode, where the light simply reflects from the surface of 
the sample. 
 
Logarithmic – Film Transparency Scan – This method may be used for 
film images that were scanned in a transparency mode. Transparency scanners 
can shine light completely through the film sample to obtain the image. 
Caution! This method may result in large errors in the concentration values as 
the pixel intensities approach saturation. 
 
 
Scan Direction - gel analysis options  
 
This option allows you to select the direction in which UN-SCAN-IT gel 
analyzes the gel data and numbers the corresponding bands in each lane. 
 
Top to Bottom - This method analyzes the image in the top to bottom 
direction. Use this method if the bands migrate from the top of the image to 
the bottom of the image. 
 
Bottom to Top - This method analyzes the image in the bottom to top 
direction. Use this method if the bands migrate from the bottom of the image 
to the top of the image. 
 
Lane/Segment Drawing Mode - gel analysis options  
 
This option allows you to select the drawing mode that will be used to draw 
the lane or segment boxes on the image.  
 
Lanes 
 
Standard Drawing Mode - This method allows the user to draw each lane 
box individually by simply clicking and dragging the mouse cursor. The lane 
boxes can also be re-sized and moved individually. 
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Clone Drawing Mode - This method duplicates the single user defined lane 
box at specified horizontal offsets. Re-sizing or moving any lane box will re-
size and move all other lanes on the image. 
 
Lanes - This is the total number of lane boxes to be drawn on the image when 
using Clone Mode. The lanes value can be adjusted from the options menu 
when drawing. 
 
Horizontal Spacing - This is the horizontal offset (in scanner pixel units) 
between lane boxes in Clone Mode. The spacing value can be adjusted from 
the options menu or toolbar when drawing. 
 
Segments 
 
Standard Drawing Mode -This method allows the user to draw each 
segment box individually by simply clicking and dragging the mouse cursor. 
The segment boxes can also be re-sized and moved individually. 
 
Clone Drawing Mode - This method duplicates the single user defined 
segment box at specified horizontal and vertical offsets. Re-sizing or moving 
any segment will re-size and move all other segments on the image. 
 
Columns/Rows - This is the total number of segment columns and rows to be 
drawn on the image when using Clone Mode. The number of cols/rows can be 
adjusted from the options menu when drawing. 
 
Horizontal/Vertical Spacing - This is the horizontal and vertical offset (in 
scanner pixel units) between each segment in Clone Mode. These values can 
be adjusted from the options menu when drawing. 
 
 
 Lane Width - gel analysis options  
 
This option allows you to select variable widths or a fixed single pixel width 
to each lane. Generally variable lane widths are most useful for including all 
pixels in the lane; however, the single pixel method can be useful in reducing 
problems with 'smiles' or 'tilted' lanes. 
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Variable - This option allows the lane boxes to be drawn at any user defined 
width. The lane box should generally encompass the width of the entire lane. 
 
Single Pixel - This option only allows lane boxes to be drawn with a width of 
a single scanner pixel unit. 
 
 
Lane/Segment Box Line Type - gel analysis options  
 
This option allows you to select the line type for the lane and segment boxes 
drawn on the main gel image. 
  
Solid – Solid line boxes.  
 
Dashed – Dashed line boxes. 
 
Dotted – Dotted line boxes. 
 
 
Saturation Checking - gel analysis options  
 
This option allows you to select if a warning will be displayed if the image 
appears to be saturated. Image saturation may result in a loss of resolution for 
the most intense bands. 
  
Off - This option ignores instances when multiple adjoining pixels are at the 
same apparent saturation value. 
 
On - This option provides a warning when multiple adjoining pixels are at the 
same apparent saturation value. 
 
 
ACGT Sequence Mode  - gel analysis options  
 
This option provides a method for assigning ACGT values to the bands in a 
sequencing gel. 
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Off -This option assumes the image is a standard gel, and does not attempt to 
determine the base pair (ACGT) sequence for the gel. 
 
On -This option determines the base pair (ACGT) sequence for a DNA type 
gel based on migration distance of bands in the A, C, G, and T lanes. This 
method only allows a maximum of 4 lanes. This option is only available in 
lanes mode. 
 
 
Digitizing Speed - gel analysis options  
 
This option allows you to select the speed used for the digitizing portion of 
the lane or segment analysis. The digitizing speed selected does not affect the 
quality of the data. 
  
Standard – This option displays the gel digitizing process as the image is 
being digitized.  
 
Turbo – This option does not display the gel digitizing process as the image 
is being digitized. This option can be used when maximum digitizing speed is 
required.  
  
 
5.6  Gel Analysis Screen 
 
After the gel analysis options are selected, the main gel analysis screen will  
be displayed. The main analysis screen displays the main image, a crosshair 
magnification window (which displays a image resolution view of the region 
surrounding the crosshair, box position grid that displays the coordinates of 
the lane or segment boxes, and a message region that guides the user through 
the analysis process. 
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As the lane and segment boxes are defined, the currently highlighted box will 
flash, and the coordinates will appear highlighted in the box position grid. The 
current pixel location and value at the center of the crosshair magnification 
window will appear at the bottom corner of the message region. 
  
The main menu that appears at the top of the analysis screen contains the 
following features: 
 
 Options Use this menu to adjust the lane and segment boxes, modify 

the default settings, change drawing modes, save gel data, 
etc. These options will be discussed later in this chapter. 

 
 Help Select Help to display help topics relating to the setup, 

analysis, general options and results of the analysis process.  
 
 Exit   Select Exit to exit the analysis screen and return to the main 

menu.  
 
 
Options – gel analysis screen 
 
The Options menu contains the following options: 
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Copy Current Lane/Segment Use this option to create an additional 

lane or segment box with the same width 
and height properties as the currently 
selected (highlighted) lane or segment. 
Lane and segment boxes can be 
highlighted by moving the mouse cursor 
over the box or by clicking on the box 
row in the box position grid.  

 
Delete Current Lane/Segment Use this option to delete the currently 

selected (highlighted) lane or segment. 
Lane and segment boxes can be 
highlighted by moving the mouse cursor 
over the box or by clicking on the box 
row in the box position grid. 

  
Delete All Lanes/Segments Use this option to delete all currently 

defined lanes or segments. 
  
Slide All Lanes/Segments Use this option slide the positions of all 

currently defined lanes or segments. This 
feature can be especially useful when 
analyzing multiple gel images where 
saved lane or segment positions have 
been loaded, and there is a slight shift in 
the lane or segments positions between 
images. 

 
Align Lanes/Segments Use this option to align all lanes or 

segments with respect to the currently 
selected (highlighted) lane or segment. 
Alignment can be with respect to either 
position or size of the selected lane or 
segment. Lane and segment boxes can be 
highlighted by moving the mouse cursor 
over the box or by clicking on the box 
row in the box position grid. 
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Lane/Segment Drawing Method  Use this option to switch between 

standard and clone drawing methods for 
lane or segment boxes. Details regarding 
the different drawing method choices can 
be found by selecting help during the gel 
analysis options setup process. 

 
Lane/Segment Clone Settings Use this option to modify the clone 

drawing settings. Lanes: The number of 
lanes and the horizontal spacing of the 
lanes can be adjusted. Segments: The 
number of segment columns and segment 
rows can be adjusted, along with the 
horizontal and vertical spacing of the 
segments. 

 
MW Calculation Method Use this option to switch between 

different methods for fitting the unknown 
molecular weight values to the known 
molecular weight values in the final gel 
results. Caution: When calculating 
Molecular Weight values based on the 
log of MW, small differences in Y 
Position can cause large differences in 
calculated MW values. 

 
Lane/Segment Label Positions Use this option to move the positions of 

the lane or segment labels in order to 
allow band features to be viewed without 
being covered by the segment labels. The 
Segment labels can be edited by double 
clicking on the segment label in the box 
positions grid, or double clicking on the 
label on the main gel image. 

 
Hide/Show Segment Labels Use this option to switch between hiding 

and showing the lane or segment labels. 
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This feature can be useful to allow band 
features to be viewed without being 
covered by the segment labels. 

 
Set Digitizing Speed Use this option to change the current 

digitizing speed. 
 
Set Main Image View Use this option to change the current 

main image view to either Maintain 
Aspect Ratio or Stretch to Fit. This 
option can also be used to set the zoom 
level and increase the size of the image 
within the viewing area. Note: Analysis 
may be slower while image is zoomed. 

 
Distance Measuring Tool Use this option to activate the distance 

measuring tool. This tool may be used to 
measure distance on the image in the 
horizontal (x), vertical (y), and 
combined (z) directions. Simply click 
the mouse at the point where you wish 
to begin the measurement, and drag the 
mouse cursor to any point on the image. 
The data can be displayed in pixels, 
inches, or centimeters (inches and 
centimeters measurements depend upon 
the dpi value of the original image 
which may not be available in some 
images). 

 
Hide/Show Y Position Lines Use this option to switch between 

Hiding and Showing the Y Position 
Lines. This feature can be useful to 
allow band features to be viewed 
without being obscured by the Y 
Position Lines. 

  
Expand/Reduce Results Grid Use this option to increase or decrease the 
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number of rows displayed in the results 
grid. 

 
Set Screen Colors   Use this option to change the current 

screen colors used by the software. The 
crosshair color, segment box color, 
density profile peak colors, etc. can be 
adjusted. Setting these display options 
can be useful in making some features 
more visible on the analysis screen. 

 
Current Settings and Image Info Use this option to display the current 

analysis and setup options that have been 
selected, as well as some general 
information regarding the current image. 

 
Copy Screen Image to Clipboard Use this option to Copy the current 

analysis Screen Image to the Clipboard. 
The screen image can then be Pasted 
into another program (word processor, 
graphics, etc.). 

 
Save Gel Data       Use this option to save the gel data values 

to a standard data file. The saved data file 
can then be read into other programs, 
such as spreadsheet, data analysis, or 
graphics software. 

 
Load Lane/Segment Positions Use this option to load previously saved 

lane or segment positions. This option 
can be very useful for retrieving 
previously saved lane or segment 
positions in order to re-analyze a previous 
image or analyze another similar image, 
without having to re-define the lane or 
segment positions. 

 
Save Intensity Calibration Data Use this option to save the intensity 
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calibration data for the current gel. The 
saved calibration file can then be used at a 
future time for this gel image or another 
similar gel image. 

 
 
5.7  Drawing Lanes, Segments, and Dot Blots  
 
Lane, segment, and dot blot boxes can all be defined in a similar manner by 
clicking and dragging the mouse within the main image. 
 

 
 
Lanes - drawing 
 
Lane boxes can be created by clicking and dragging the mouse within the 
main image to draw the box. The box will then be numbered, and the box 
coordinates will be displayed in the box position grid at the right side of the 
analysis screen. The crosshair magnification window in the upper right corner 
of the screen can be used for precise alignment. To obtain optimal 
quantification, the boxes should generally be drawn large enough to include 
the entire region of interest for each  band. 
 
Lane boxes can be highlighted by moving the mouse cursor over the box or 
by clicking on the box row in the box position grid. The highlighted box will 
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be the box upon which copying, deleting, aligning, clone drawing, and other 
modifications will center. 
 
Lane boxes can be moved by locating the mouse cursor over the box and 
dragging the box to a new location. Boxes can be re-sized by locating the 
mouse cursor over the edge of the box and dragging to the desired size. Boxes 
can also be moved and re-sized by double clicking on the box position grid on 
the right side of the analysis screen. 
 
Lanes should be drawn as rectangles that enclose the entire lane of interest, 
without including any portion of bands contained in another lane. It is 
generally not necessary to draw irregularly shaped lane boxes, as any 
background pixels included in the lane box can be ignored in the density 
profile screen by correctly setting the baseline. Band smiling effects can be 
minimized by setting the lane width to 1 pixel. 
  
 
Segments - drawing 
 
Segment boxes can be created by clicking and dragging the mouse within the 
main image to draw the box. The box will then be numbered, and the box 
coordinates will be displayed in the box position grid at the right side of the 
analysis screen. The crosshair magnification window in the upper right corner 
of the screen can be used for precise alignment of the segment. To obtain 
optimal quantification, the boxes should generally be drawn large enough to 
include the entire region of interest for each band. 
 
Segment boxes can be highlighted by moving the mouse cursor over the box 
or by clicking on the box row in the box position grid. The highlighted box 
will be the box upon which copying, deleting, aligning, clone drawing, and 
other modifications will center. 
 
Segment boxes can be moved by locating the mouse cursor over the box and 
dragging the box to a new location. Boxes can be re-sized by locating the 
mouse cursor over the edge of the box and dragging to the desired size. Boxes 
can also be moved and re-sized by double clicking on the box position grid on 
the right side of the analysis screen. 
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Segments should be drawn as rectangles that enclose the entire band of 
interest, without including any portion of other bands. It is generally not 
necessary to draw irregularly shaped segment boxes, as there are several 
background correction options available in the setup portion of the software 
that will reduce or eliminate any background effects. These background 
corrections can allow band quantification relatively independent of box size 
and shape. If the background is not zero and no background correction is 
selected, the segment boxes should all be drawn the same size to minimize 
background effects. 
 
 
Dot Blots - drawing 
 
Dot blot boxes/ellipses can be created by clicking and dragging the mouse 
within the main image to draw the box/ellipse. The box/ellipse will then be 
numbered, and the box/ellipse coordinates will be displayed in the grid at the 
right side of the analysis screen. The crosshair magnification window in the 
upper right corner of the screen can be used for precise alignment of the 
box/ellipse. To obtain optimal quantification, the boxes/ellipses should 
generally be drawn large enough to include the entire region of interest for 
each blot. 
 
Dot blot boxes/ellipses can be highlighted by moving the mouse cursor over 
the box or by clicking on the box row in the box position grid. The 
highlighted box/ellipse will be the box/ellipse upon which copying, deleting, 
aligning, clone drawing, and other modifications will center. 
 
Dot blot boxes/ellipses can be moved by locating the mouse cursor over the 
box and dragging the box to a new location. Boxes/ellipses can be re-sized by 
locating the mouse cursor over the edge of the box and dragging to the desired 
size. Boxes/ellipses can also be moved and re-sized by double clicking on the 
box position grid on the right side of the analysis screen. 
 
Dot Blot segments should be drawn as rectangular boxes with interior circular 
regions (ellipses) that enclose the entire blot of interest, without including any 
portion of other blots. Only the circular region of the segment will be 
analyzed. It is generally not necessary to draw irregularly shaped dot blot 
boxes/ellipses, as there are several background correction options available in 
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the setup portion of the software that will reduce or eliminate any background 
effects. These background corrections can allow band quantification relatively 
independent of box/ellipse size and shape. If the background is not zero and 
no background correction is selected, the segment boxes/ellipses should all be 
drawn the same size to minimize background effects. 
 
 
5.8  Begin Analysis 
 
Once all of the lanes, segments, or dot blots have been defined, click the 
Analyze button at the lower right corner of the analysis screen. 
UN-SCAN-IT gel will then begin automatically digitizing and analyze the gel 
image. 
 
 
5.9  Gel Analysis Mode 
 
The method used for analysis the gel image varies depending upon whether 
you selected Lane Analysis, Segment Analysis, or Dot Blot Analysis during 
the  Gel Analysis Mode setup portion of the program. 
 
Lane Analysis – gel analysis mode  
 
When the image digitizing process begins, UN-SCAN-IT gel extracts a 
density profile for each lane, based upon each pixel value in that lane. Each 
pixel value is between 0 and 255, and may have been adjusted for background 
if that option was selected during the setup process.  
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Density Profile - General 
Each (x,y) data point in the Density Profile is 
obtained by summing the grayscale pixel values 
horizontally across the lane. As a result, bands 
manifest themselves as peaks in the Density 
Profile. Generally the more intense the band... 

the higher the peak, and the larger the band... the wider the peak. Therefore, 
integrating the area under these peaks accounts for both the intensity and size 
of each band. The integrated peak area can then be related to the relative 
concentrations for each of the bands (assuming the bands are not saturated 
and the optical intensity of the gel bands are relatively linear). 
 
 

Density Profile - Peaks 
The UN-SCAN-IT gel software will 
automatically find the peaks in the Density 
Profile, and set the corresponding baseline. 
Noise, overlapping peaks, weak signals, etc. may 
cause the software to miss peaks, find extra 

peaks, or not set the endpoints of some peaks at their proper locations. 
Therefore, the software has a toolbar for adding or deleting peaks, as well as a 
method for adjusting the endpoints of any peak. To adjust the endpoint of any 
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peak, simply click the mouse on the drag box associated with that endpoint. 
The drag box and baseline will change color, and the endpoint can be dragged 
to the desired location on the Density Profile. Density Profile peaks cannot 
overlap. 
 
 

Density Profile - Baselines 
The baselines for each peak are straight lines 
drawn from the left endpoint to the right 
endpoint of each peak. These baselines should 
generally approximate the local minima for each 
peak. This baseline is used to determine the 

background values for each peak, and thus the integrated area of each peak 
will only include values above the local background. Proper placement of 
baselines is critical to obtaining accurate peak quantification. Proper 
adjustment of peak baselines can also be used to separate doublet peaks, or the 
Resolve Peaks feature can be used. 
 
 
Density Profile Toolbar – lanes digitizing  mode  
 
The density profile screen will also display a toolbar containing a variety of 
buttons for use in quantifying each peak/band in the lane. The functions of 
these buttons are described below. 
 
 

 
 
Quantify Peaks / Continue - Quantify Peaks integrates the area of each 
defined peak in the Density Profile. The integrated values are displayed under 
each peak and carried over to a spreadsheet for later analysis. Continue 
moves on to the Density Profile for the next lane. If the final lane has been 
quantified, the Results screen will then be displayed. 
 
Step Back/Undo – Step Back to return to the previous Density Profile. If the 
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current Density Profile is for the first lane, the program will return to the lane 
drawing portion of the software. Undo to remove the peak integration for the 
current Density Profile in order to add peaks, delete peaks, or modify peak 
endpoints. 
 
Add Peak - This feature allows a peak to be manually added to the Density 
Profile. Click the mouse at the location on the Density Profile where you wish 
to add the peak, then drag the peak endpoints to their desired locations. The 
added peak cannot overlap any of the other currently defined peaks. 
 
Delete Peak - This feature allows a peak to be manually deleted from the 
Density Profile. Click the left mouse button at the peak location on the 
Density Profile where you wish to delete the peak. Clicking the right mouse 
button on the Density Profile will delete all peaks. 
 
Auto Find - This feature searches for peaks in the current density profile to 
find and assign peaks. The Peak Find feature is executed automatically when 
each density profile is first loaded and displayed. Re-running this feature can 
be useful if peaks were erroneously deleted or modified. In addition, this 
feature allows the Automatic Peak Finding Settings to be modified. 
 
Set Baseline - This feature allows the baseline for all current peaks to be set 
to a single user defined value. Generally this function is not necessary, as peak 
baselines should most often be set at the natural minimum that occurs at the 
edge of each peak, and thus the baseline should vary accordingly for each 
peak. However, there may be circumstances where it is desirable to set the 
baseline to a common value for all peaks, therefore,  the Set Baseline feature 
is available for this purpose. 
 
Resolve Peaks - The software may miss peaks, find extra peaks, or not 
resolve overlapping peaks. The Resolve Peaks feature can be used to 
overlay Gaussian peaks on the density profile to estimate where the baseline 
should be set if the peaks were represented by a Normal distribution. The 
three Gaussian peaks in the upper left corner of the density profile can be 
used to overlay the peaks you wish to fit. You can use one, two, or all three 
of the Gaussian peaks to fit single, double, or triple peaks. The Gaussian 
peaks should be dragged and resized to overlay the density profile peaks 
you wish to fit. To obtain the best fit, you may wish to Maximize the 
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Window to assist in visually overlaying the peaks. After the Gaussian peaks 
have been overlaid on the density profile, press Enter to automatically 
estimate the locations of the baselines that best fit the density profile for 
those peaks. Confirm visually that the new baseline locations are 
acceptable. Additional sessions using the Resolve Peaks feature can allow 
additional peaks to be resolved for that lane. 
 
Save Density Profile as (x,y) Data - This features allows the (x,y) data 
values that make up the Density Profile to be saved to a file. The x values 
represent the row distances from the edge of the gel, and the y values 
represent the pixel sums across each row of the lane. The data can be saved in 
(x,y) ASCII format, that can be exported into graphing or spreadsheet 
programs for further analysis or presentation. 
 
Copy Screen Image to Clipboard - Use this option to Copy the current 
density profile Screen Image to the Clipboard. The screen image can then 
be Pasted into another program (word processor, graphics, etc.).  
 
 
Segment Analysis - gel analysis mode  
 
 
When the image digitizing process begins, UN-SCAN-IT gel sums the pixel 
values for all pixels within each rectangular segment region. Each pixel value 
is between 0 and 255, and may have been adjusted for background if that 
option was selected during the setup process.  
 
When the digitizing process is complete, UN-SCAN-IT gel overlays the band 
segment boxes on the main image, and a results grid is displayed at the bottom 
of the gel analysis screen.  
 
 
Dot Blot Analysis - gel analysis mode  
 
When the image digitizing process begins, UN-SCAN-IT gel sums the pixel 
values for all pixels within each elliptical segment region. Each pixel value is 
between 0 and 255, and may have been adjusted for background if that option 
was selected during the setup process.  
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When the digitizing process is complete, UN-SCAN-IT gel overlays the band 
segment boxes/ellipses on the main image, and a results grid is displayed at 
the bottom of the gel analysis screen.  
 
 
5.10  Results 
 
General Results - results 
 
Simply because the software obtains a digitized value for a gel segment... that 
does not assure the accuracy of that data value. Scientific expertise, visual 
approximation, and common sense should be used to verify the gel data. 
Obtaining consistent and accurate gel analysis results requires consideration 
of all processes involved in quantifying a gel, including... 
 

Chapter 5: Analyzing Gels  41 



 

Experimental - The experimental portion is the first and most important step 
to accurately quantifying a gel. Accurately quantifying a gel may be difficult 
or impossible if one or more of these conditions are prevalent... 
   
-  Non-Linear dyes (or other indicator methods) 
-  Band saturation 
-  Overlapping bands or 'smiling' bands 
-  Tilted lanes or bands 
-  Smudged bands 
- etc. 
 
 
Obtaining the Image - Obtaining a good image is the second most important 
step to accurately quantifying a gel. Whether the image is obtained with a 
scanner, a digital camera, or other image input device, the image should be... 
 
-  Scanned straight with no significant tilt 
-  Right side up with gel bands migrating up or down 
-  Not saturated 
-  Near the middle of the dynamic range of the scanner 
-  Reasonably high resolution (generally 150 - 600 dpi) 
-  Saved in a compatible image format 
 
 
Software Analysis - The software analysis is the third most important step to 
accurately quantifying a gel. If the experimental or obtaining the image steps 
were not performed properly, then no software analysis will be able to obtain 
accurate results. Although this software is designed to be powerful and 
intuitive, please let us know if you have any questions or need assistance 
quantifying your gel images. 
 
 
Results Screen - results 
 
After the digitizing process is complete for the gel image, a results screen will 
be shown, and a variety of quantified gel parameters displayed. 
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Results Grid - results 
 
The results grid is located at the bottom of the gel analysis screen. The gel 
results displayed in this grid can be used to estimate concentrations, relative 
mobility, and molecular weight values for each segment. The size of the grid 
can be expanded or reduced by selecting the Expand/Reduce Grid option. The 
gel parameter definitions are described below, or can be displayed by clicking 
on the grid column headings at the top of the results grid. 
 
Segment   This column displays the Segment labels that correspond to 

each analyzed Segment. The Segment labels can be edited 
by double clicking on the segment label in the results grid, 
or double clicking on the segment label on the main gel 
image. 

 
Pixel Total This column displays the Pixel Total that corresponds to 

each analyzed Segment. The Pixel Total reflects any 
corrections that were made to adjust for background. The 
Pixel Total values are generally what is used to calculate 
the relative Concentrations of gel bands. The Pixel Total 
values are calculated by the software, and cannot be 
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directly modified. 
 
Concentration This column displays the Concentration that correspond to 

each analyzed Segment. These values will be displayed as 
zero until a Concentration calibration has been performed 
for the gel. The Concentration can be calibrated by double 
clicking on the Concentration value for the Segment of 
known Concentration, and entering that Concentration 
value. Entered values will be indicated by an asterisk. Once 
two or more Concentration values have been entered, a 
least squares equation will be used to fit the Concentrations 
of the remaining Segments. To erase a calibration value for 
a Segment that has been entered, double click that 
Segment's Concentration value and enter zero (0). The 
Concentration calibration curve can be displayed by 
clicking the Show Concentration button on the toolbar. 

 
Y Position This column displays the Y Position that corresponds to 

each analyzed Segment. This position is generally chosen at 
the most intense vertical portion of the Segment. The Y 
Positions can be modified by double clicking on the Y 
Position value in the grid, or by using the mouse to drag the 
dashed Y Position line on the main gel image.  

 
Rel Mobility This column displays the Relative Mobility for each 

analyzed Segment. This value is calculated using the Y 
Position values, and is relative to a user defined starting 
point and ending point (tracking dye). These values will be 
displayed as zero until the starting and ending point have 
been defined. 

 
Mol Weight This column displays the Molecular Weight values that 

correspond to each analyzed Segment. These values will be 
displayed as zero until a Molecular Weight calibration has 
been performed for the gel. The Molecular Weight values 
can be calibrated by double clicking on the Molecular 
Weight value for the Segment of known Molecular Weight, 
and entering that Molecular Weight value. Entered values 
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will be indicated by an asterisk. Once two or more 
Molecular Weight values have been entered, a least squares 
equation will be used to fit the Log MW relative to the Y 
position of the remaining Segments. To erase a calibration 
value for a Segment that has been entered, double click that 
Segment's Molecular Weight value and enter zero (0). In 
order to obtain the best fit, several Molecular Weight 
calculation methods are available from the Options Menu. 
The Molecular Weight calibration curve can be displayed 
by clicking the Show MW button on the toolbar. 

 
Pixel Total % This column displays the Pixel Total % that corresponds to 

each analyzed Segment. In Lanes mode, the Pixel Total % 
will correspond to the relative percentage of that Segment's 
Pixel Total to the Pixel Total for all of the defined 
Segments in that Lane. In Segments mode, the Pixel Total 
% will correspond to the relative percentage of that 
Segment's Pixel Total to the Pixel Total for all of the 
defined Segments in the entire gel. The Pixel Total % 
values are calculated by the software, and cannot be 
directly modified. 

  
Segment Size This column displays the Segment Size that correspond to 

each analyzed Segment. The Segment Size is determined 
by simply multiplying the Segment width by the Segment 
height (in pixel units) for rectangular segments, or is simply 
the total number of pixels (i.e. area) digitized within the 
elliptical Segment region for dot blots. The Segment Size 
values are calculated by the software, and cannot be 
directly modified. 

 
Segment Size % This column displays the Segment Size % that corresponds 

to each analyzed Segment. In Lanes mode, the Segment 
Size % will correspond to the relative percentage of that 
Segment's Size to the Segment Size total for all of the 
defined Segments in that Lane. In Segments mode, the 
Segment Size % will correspond to the relative percentage 
of that Segment's Size to the Segment Size total for all of 
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the defined Segments in the entire gel. The Segment Size % 
values are calculated by the software, and cannot be 
directly modified. 

 
Maximum Pixel This column displays the Maximum Pixel value measured 

within that segment (value can range from 0 to 255). The 
Maximum Pixel value reflects any corrections that were 
made to adjust for background. The Maximum Pixel values 
are calculated by the software, and cannot be directly 
modified. 

 
Average Pixel This column displays the Average Pixel value measured 

within that segment (value can range from 0 to 255). This 
value is calculated by taking the Pixel Total and dividing by 
the Segment Size. The Average Pixel value reflects any 
corrections that were made to adjust for background. The 
Average Pixel values are calculated by the software, and 
cannot be directly modified. 

 
 
5.11  Normalize 
 
The Pixel Total values for all segments can be Normalized to a user defined 
segment by clicking the Normalize button above the results grid. 
Normalization can be undone. 
 
 
5.12  Calibrating Concentration Values 
 
The Concentration values can be calibrated by double clicking on the 
Concentration value for the Segment of known Concentration, and entering 
that Concentration value. Entered values will be indicated by an asterisk. 
Once two or more Concentration values have been entered, a least squares 
equation will be used to fit the Concentrations of the remaining Segments. To 
erase a calibration value for a Segment that has been entered, double click that 
Segment's Concentration value and enter zero (0). 
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5.13  Editing Y Position Values 
 
The Y Positions can be modified by double clicking on the Y Position value 
in the grid, or by using the mouse to drag the dashed Y Position line on the 
main gel image. 
 
 
5.14  Calibrating Relative Mobility Values 
 
By double clicking on the Rel Mobility column, the start Y Position and 
tracking dye Y Position can be defined. 
 
 
5.15  Calibrating Molecular Weight Values 
 
The Molecular Weight values can be calibrated by double clicking on the Mol 
Weight value for the Segment of known MW, and entering the MW value. 
Entered values will be indicated by an asterisk. Once two or more MW values 
have been entered, a least squares equation will be used to fit the Log MW 
relative to the Y position of the remaining Segments. To erase a calibration 
value for a Segment that has been entered, double click that Segment's MW 
value and enter zero (0). Caution: MW values as a function of the Log(MW) 
may potentially contain large errors, as small differences in position can 
equate to large differences in MW due to the Log function. 
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5.16  Show Concentration Curve 
 

 
 
Clicking the Show Concentration Curve button will display a least squares fit 
of the Concentrations for all segments as calculated relative to any standard 
Concentrations that have been entered for known segments. Two or more 
segments of known Concentrations must be entered before the least squares fit 
can be applied and the results displayed. The least squares equation will be 
displayed at the top of the graph. 
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5.17  Show Molecular Weight Curve 
 

 
 
Clicking the Show Mol Weight Curve button will display a least squares fit of 
the Log MW (or Linear MW) values for all segments as calculated relative to 
any standard Molecular Weight Values that have been entered for known 
segments. Two or more segments of known Molecular Weight must be 
entered before the least squares fit can be applied and the results displayed. 
The least squares equation will be displayed at the top of the graph. 
 
5.17  Helpful Hints 
 
- When drawing lanes, draw lane limits well above and below the end of the 
lane. 
 
- When analyzing lanes, manually adjust any peak baselines that are not near 
the local minima in the density profile screen. 
 
- When drawing lanes or segments, draw the box wide enough to encompass 
all of the pixels to be included with that band. 
 
- Use background corrections for segments or dot blots. 
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 Chapter 6 
 
 DIGITIZING (X,Y) GRAPHS 
 
 
6.1  Overview 
 
This chapter will guide you through the digitizing process for graphical 
images, and explore the options available in the UN-SCAN-IT gel software. 
In this chapter you will be instructed to drag the setup icons and move the 
digitizing crosshair to different locations on the image. These movements can 
be accomplished with the mouse, the keyboard arrow keys for fine movement, 
or the Ctrl + arrow keys for coarse movements. Some of the options 
described in this chapter may not be encountered in every digitizing session. 
 
Many of the UN-SCAN-IT gel digitizing menu options can also be accessed 
from the toolbar located below the menus. Help menus and context sensitive 
help buttons can be used to provide helpful information regarding the 
digitizing controls and options. 
 
UN-SCAN-IT gel is designed as a general tool for extracting data from 
images. As with any tool, the accuracy of the results can be largely dependent 
upon how that tool is used. The accuracy of the digitized data is not only a 
function of the UN-SCAN-IT gel software, but is also dependent upon the 
original conditions of the experiment, the quality of the image, as well as the 
set-up processes and interaction performed by the user. Inherent limitations 
exist in converting image information to digital data, and thus the accuracy 
and precision of the data should not be assumed by the user. Please contact 
Silk Scientific if you have any questions regarding the accuracy of the results 
obtained using this product. 
 
 
6.2  Main Menu 
 
To enter the (x,y) graph digitizing portion of the UN-SCAN-IT gel program 
from the main menu, select: 
 
 Digitize Graph 
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Digitize (x,y) Graph Image - main menu 
 
Select Digitize New (x,y) Graph Image… to digitize a graph that was saved 
in a compatible image format. 
  

 
 
 

Return to Current (x,y) Graph Image - main menu 
 
Select Return to Current (x,y) Graph Image… to return to a currently 
selected graph and allow additional points on the graph to be digitized without 
requiring the re-entry of the graph's scaling points. All digitized data points 
currently in memory will be drawn to the screen, or the data points can be 
cleared by selecting Clear Current (x,y)) Data from the Options menu in 
the digitizing screen. 
 
 
6.3  Open Image File 
 
If Digitize New (x,y) Graph Image… was selected from the main menu, a 
Windows file dialog box will appear (only acceptable image files with the 
appropriate file extensions will appear in the list of files that can be selected). 
Select the image you wish to digitize. 
 
Sample Images 
Several sample images are also included in the UN-SCAN-IT gel folder. You 
may find it useful to load and digitize one of these sample images before 
trying one of your own images. These sample images assist you in identifying 
the axis setup parameters, and are relatively straightforward to digitize. 
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PDF Files 
UN-SCAN-IT gel does not currently accept PDF files. PDF files often 
contain multiple pages, imbedded text, and variable dpi settings, which can 
present difficulties in extracting accurate and useful digitized data. The 
PDF file should be converted to one of the standard image formats listed 
earlier in this manual. 
 
 
6.4  Graph Digitizing Mode 
 
All UN-SCAN-IT gel digitizing modes (except Polar Digitizing Tablet) 
assume an (x,y) Cartesian Coordinate system where the x axis and y axis are 
orthogonal (right angles). UN-SCAN-IT gel does not digitize circular graphs 
or graphs that are recorded in a format other than standard (x,y) Cartesian 
Coordinates 
 
The Graph Digitizing Mode allows you to select the type of digitizing to be 
performed on your image. 
 
 

 
 
Standard Line 
(Automatic Line Follow for Standard Curves) 
In this mode, UN-SCAN-IT gel follows a line on the graphical image. The 
crosshair automatically searches up and down (as it moves along the line) 
until it finds the line and records the single valued (x,y) point. Then the 
crosshair automatically increments 1 resolution unit in the X direction, and 
repeats the point assignment process until digitizing is completed. The default 
line follow direction is left to right, and the default resolution is 1 scanner unit. 
These default settings can be modified in the Options portion of the 
Digitizing Screen. This mode is most useful for digitizing single line (x,y) 
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graphs or multiple curves that do not intersect. Extraneous points, marks and 
labels in the digitizing region generally do not present a problem unless they 
touch or overlap the curve of interest. The automatic digitizing process can be 
paused at any point by pressing the Enter key or selecting the Pause button. 
 
 
 

 
 
Intersecting Line 
(Automatic Line Follow for Intersecting Curves) 
This mode is the same as Standard Line, except that this mode includes 
features for dealing with intersecting curves. Pause Bars can be manually 
inserted along the curve, which cause the software to pause at these 
intersection points. Additionally, an overlap search can be used to 
automatically estimate the location of intersection points during the digitizing 
process. This mode is most useful for digitizing (x,y) graphs with multiple 
curves that intersect. The automatic digitizing process can be paused at any 
point by pressing the Enter key or selecting the Pause button. 
 
 
 

 
 
Cyclic Graph 
(Automatic Line Follow with Auto Turn Around) 
This mode is the same as Standard Line, except that the user is prompted to 
select a turn around point where the software automatically changes Line 
Follow Direction and Line Follow Side when the turn around point is 
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encountered. This mode is most useful for digitizing cyclic graphs such as 
cyclic voltamograms. The automatic digitizing process can be paused at any 
point by pressing the Enter key or selecting the Pause button. 
 
 
 

 
 
Bar Graph/Mass Spec 
(Automatic Line Follow w/  Bar Graph Spacing) 
This mode is the same as Standard Line, except that upon completion of the 
digitizing process for the curve/bar graph, the data can be converted to bar 
graph type values. This mode allows the data to be converted to discrete, 
evenly spaced-bar type values by finding the nearest X (and associated Y) 
value for each step along the X-axis. This mode is most useful for bar graphs 
such as mass specs. The automatic digitizing process can be paused at any 
point by pressing the Enter key or selecting the Pause button. 
 
 
 

 
 
Dashed/Dotted Line 
(Automatic Line Follow with Interactive Line Limits) 
This mode is similar to Standard Line, except the user will select a limited 
vertical search region that will be guided along the curve with the mouse. 
While the mouse button is depressed, the crosshair will automatically follow 
along the data line closest to the current position of the mouse cursor, and will 
not search beyond the vertical limits shown above and below the mouse 

Chapter 6: Digitizing (x,y) Graphs  55 



 

cursor. Additionally, the crosshair will not proceed horizontally beyond the 
current position of the mouse cursor. This process allows broken lines to be 
digitized without the crosshair jumping to another curve. This mode is most 
useful for graphs that contain one or more curves that are not continuous 
(such as dashed line, dotted lines, etc.). Extraneous points, marks, and labels 
in the digitizing region where the line is not continuous may present a 
problem and should be cleaned up during the scanning process. The digitizing 
process can be paused at any point by simply releasing the mouse button 
during digitizing. 
 
 
 

 
 
Contour Plot 
(Automatic Line Follow w/ Interactive Line Limits and Auto Turn Around) 
This mode is the same as Dashed/Dotted Line, except when the crosshair 
encounters a location where no data line is present; the software automatically 
changes Line Follow Direction and Line Follow Side to follow the contour of 
the curve. This mode is most useful for digitizing non single-valued curves 
such as contour plots. The digitizing process can be paused at any point by 
simply releasing the mouse button during digitizing.. 
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Shapes/Drawings 
(Automatic Raster Scan w/ All Points Accepted as Data) 
In this mode, UN-SCAN-IT gel searches an entire user-selected rectangular 
area in both the X and Y directions, and records the position of all of the data 
points in the specified region. This mode is most useful for digitizing shapes, 
figures, and drawings. Extraneous points, marks and labels in the digitizing 
region present a problem, and should be cleaned up during the scanning 
process. The data from the raster scan method are not vectorized and the data 
array is not in sequential order. This raster scan digitizing mode can fill 
memory very quickly as large numbers of pixels are digitized. The automatic 
digitizing process can be paused at any point by pressing the Enter key or 
selecting the Pause button. 
 
 
 

 
 
Symbols/Scatter Plot 
(Auto Raster Scan w/ Contiguous Data Points Converted to  Single Point) 
This mode is the same as Shapes/Drawings, except that this mode searches the 
entire rectangular region specifically for groups of contiguous pixels, and 
records only the position of the center of each pixel group as a data point. This 
mode is most useful for images that contain scattered non-connected data 
points or symbols (e.g. circles, squares, etc). The digitized data is non-
vectorized. Although this digitizing mode can be useful for scatter plots, it 
may be quite slow for some images. A faster alternative to this mode may be 
the Symbols option in Manual mode. The automatic digitizing process can be 
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paused at any point by pressing the Enter key or selecting the Pause button. 
 
 
 

 
 
(x,y) Digitizing Tablet 
(Manual Mode for Standard (x,y) Coordinates) 
In this mode, the user moves the cursor to each individual point on the graph 
that they wish to digitize, and presses the Space Bar (or right mouse button) 
to store each point. If the Automatic X Increments feature is selected, the 
crosshair automatically increments one resolution unit in the X direction after 
each point is digitized. In addition, a symbol mode option is available where 
simply clicking near a symbol/data point will cause the software to do a small 
raster search, and find the center of the data point. This mode is most useful 
for digitizing scatter plots, graphs, pictures, or drawings that cannot easily be 
digitized by any of the automatic digitizing methods. 
 
 
 

 
 
Polar Digitizing Tablet 
(Manual Mode for Polar Coordinates) 
This mode is the same as (x,y) Digitizing Tablet, except that this mode is for 
digitizing graphs that have been recorded using a polar (r,theta) coordinate 
system. The user moves the cursor to each individual point on the graph that 
they wish to digitize, and presses the Space Bar (or right mouse button) to 
store each point. In addition, a symbol mode option is available where simply 
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clicking near a symbol/data point will cause the software to do a small raster 
search, and find the center of the data point. This mode is useful for digitizing 
any graph that contains polar (r,theta) coordinates. All other 
UN-SCAN-IT gel digitizing modes are for digitizing standard (x,y) 
coordinates. 
 
 
6.5  Graph Digitizing Options 
 
The Graph Digitizing Options allow you to select from the available 
UN-SCAN-IT gel digitizing options for the Graph Digitizing Mode you have 
selected. Only the options that are associated with the Graph Digitizing Mode 
selected will be displayed. 
 
 
Main Image View – graph digitizing options  
 
Maintain Aspect Ratio: This method maintains the original image aspect 
ratio in the main image viewing area. Although the image may not fill the 
entire viewing area, the image can be zoomed (1x, 2x, 4x, 8x, and 100%) to 
increase or adjust the size of the image within the viewing area. The zoom 
feature allows a closer inspection of the positioning of the setup icons, and 
also provides a more detailed view of the positions of the digitized data 
points. Note: Automatic Digitizing may be slower while image is zoomed. 
 
Stretch to Fit: This method stretches the image to fill the entire main 
viewing window, making full use of the entire image viewing area. 
Although this method may cause some images to appear distorted, the 
actual digitized data values will not be affected by the stretching. 
 
 
Color Type – graph digitizing options  
 
Although UN-SCAN-IT gel automatically determines the default Color Type 
for the current image, this option can be used to modify the color type 
selection. 
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Black and White (Line Art): This type of image contains only black and 
white (no grayscale or color) pixels. This type of image requires the least 
amount of memory, and is often the easiest to digitize. 
 
Grayscale: This type of image contains only grayscale pixels. The 
grayscale intensity range can be selected to limit the range of pixel 
intensities accepted as data, and ignore pixels outside that range. 
 
Color: This type of image contains colored pixels. This type of image 
allows only pixels of a defined color to be digitized, and thus can 
differentiate between data lines (or points) based on color. 
 
Digitize All Except Background: This color type digitizes all pixels, 
except for pixels of a defined background value. This can be useful in 
ignoring background and digitizing all other pixel values. 
 
 
Scale – graph digitizing options  
 
This option allows you to select the scale on which your original graph was 
drawn. 
 
Linear: This standard type of graph contains linear scaling in both the X 
and Y directions. This is the most common scale for graphs. 
 
Semi-Log (X-Linear): This type of graph contains linear scaling in the X 
direction, and logarithmic scaling in the Y direction. 
 
Semi-Log (Y-Linear): This type of graph contains logarithmic scaling in 
the X direction, and linear scaling in the Y direction. 
 
Log-Log: This type of graph contains logarithmic scaling in both the X and 
Y directions. 
 
Other Scales: Non-linear and Non-log formats must be input logically. 
Example: Jan 1 to Dec 31 should be entered as Day 1 to Day 365 
Example: 10:00am to 2:30pm should be entered as Hour 10.0 to Hour 14.5 
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Grid Line Filter – graph digitizing options  
 
This option is used to filter out the background grid lines on the image so 
UN-SCAN-IT gel can follow the data line more easily. 
 
None: This method provides no grid line filtering. 
 
Line Intensity (Grayscale):  This method provides grid line filtering based 
on the grayscale intensities of the data line being greater than the intensities 
of surrounding grid lines (requires grayscale image). 
 
Line Thickness:  This method provides grid line filtering based on the line 
thickness of the data line being greater than the line thickness of 
surrounding grid lines. 
 
Horiz/Vert Filter:  This method provides grid line filtering by ignoring 
horizontal and vertical lines within an adjustable search range. 
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Line Side | Point Assignment – graph digitizing options  
 
This option allows you to select the method that UN-SCAN-IT gel will use to 
follow the data curve and assign the exact location in (x,y) coordinates for 
each point. During the digitizing process, the UN-SCAN-IT gel software will 
draw a colored dot at each digitized data point location, and this dot can be 
used to gauge the accuracy of that particular point assignment method for 
your particular graph type. 
 
Upper Surface of Line: This method follows the top surface of the data 
line, and then subtracts half the general flat-line thickness to estimate the 
middle of the data line... best for upward peaks. 
 
 Advantage: Very precise and accurate for graphs with upward peaks, and 

graphs with relatively flat curves. 
 
 Disadvantage:  Does not correct for changing line thickness on sharp 

peaks, resulting in a maximum possible error on sharp peaks of up to one 
line thickness in any direction, and may have some problem properly 
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following the bottom surface of sharp downward peaks. 
 
 
Lower Surface of Line: This method follows the bottom surface of the 
data line, and then adds half the general flat-line thickness to estimate the 
middle of the data line... best for downward peaks. 
 
 Advantage: Very precise and accurate for graphs with downward peaks, 

and graphs with relatively flat curves. 
 
 Disadvantage:  Does not correct for changing line thickness on sharp 

peaks, resulting in a maximum possible error on sharp peaks of up to one 
line thickness in any direction, and may have some problem properly 
following the top surface of sharp upward peaks. 

 
 
Variable Surface of Line: This method follows the top surface when the 
data line is above a threshold, and the bottom surface when the data line is 
below a threshold... best for up and down peaks. 
 
 Advantage: Very precise and accurate for graphs with both upward and 

downward peaks. 
 
 Disadvantage:  Does not correct for changing line thickness on sharp 

peaks, resulting in a maximum possible error on sharp peaks of up to one 
line thickness in any direction. 

 
 
Both Surfaces (Mid-Line): This method follows both the top and bottom 
surfaces, and digitizes the average value... due to overlapping line 
thickness, this may greatly reduce peak heights. 
 
 Advantage:  Very precise and accurate for estimating the center of the 

data line in regions where sharp peaks are not present, as this method 
corrects for changing line thickness throughout the graph. 

 
 Disadvantage:  May cause peak heights to be significantly reduced for 

very sharp peaks, due to the lines becoming extremely thick at the top and 
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bottom of sharp peaks. 
 
 

 
 
If the data are extremely noisy, some of the data was lost when the noisy 
regions were originally printed. Although this data cannot be recovered, the 
noise can be approximated by digitizing both the top surface and the bottom 
surface of the data line. These combined data sets can then be sorted in the 
Graph portion of the UN-SCAN-IT gel software to best approximate the 
original data. 
 

 
 
 
Line Follow Direction – graph digitizing options  
 
The Line Follow Direction option allows you to choose the direction in which 
the crosshair will follow along the data line. 
 
>>> Left to Right >>>: This method digitizes the data points from left to 
right across the image. The user defined ending point must be to the right of 
the user defined beginning point. 
 
<<< Right to Left <<<: This method digitizes the data points from right to 
left across the image. The user defined ending point must be to the left of 
the user defined beginning point. 
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Line Follow Algorithm – graph digitizing options  
 
This option is to estimate the location UN-SCAN-IT gel will use to begin 
searching for the next sequential point along the curve. 
 
Sloped: This method estimates the location of the next point along the data 
curve based upon the slope of the previous points, resulting in faster line 
digitizing. 
 
Non-Sloped: This method simply moves horizontally to estimate the 
location of the next point along the data curve, resulting in slower and more 
controlled line digitizing. 
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Digitizing Speed – graph digitizing options  
 
This option is set the digitizing speed used during the automatic digitizing 
process. 
 

 
 
Fast: The faster digitizing speeds provide identical results to the slower 
speeds, but may present difficulty in allowing user interaction (pausing, 
backing up, erasing data points, manual digitizing, etc.) due to the rapid 
speed. 
 
Slow: The slower digitizing speeds provide identical results to the faster 
speeds, and allow easier user interaction (pausing, backing up, erasing data 
points, manual digitizing, etc.) due to the slower speed. 
 
Turbo: This mode does not display the crosshair movement, digitized data 
points, or the data spreadsheet as the points are being digitized. This mode 
should only be used when maximum digitizing speed is required and no 
user interaction will occur. 
 
 
Multi-Line Method – graph digitizing options  
 
This option determines the method used by UN-SCAN-IT gel digitize graphs 
with intersecting lines. 
 
Manual Pause Bars: This method allows the user to place Pause Bar icons 
at the line intersection points. The UN-SCAN-IT gel software will pause 
when it encounters these icons. 
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Overlap Search With Auto Pause: This method causes the 
UN-SCAN-IT gel software to pause automatically when an overlapping line 
is encountered. 
 
Overlap Search With Auto Continue: This method causes the 
UN-SCAN-IT gel software to estimate a probable continuance point, and 
skip to that point, when an overlapping line is encountered. 
 
 
Cyclic Line Follow Method  |  Contour Line  Start – graph digitizing 
options 
 
This option determines the starting Line Follow Direction and Line Follow 
Side when digitizing cyclic graphs or contour graphs. 
 
 
Follow Upper Surface >>> Left to Right >>> then Reverse: This mode 
starts at the leftmost point's upper surface, reverses at the rightmost point, 
and finishes back at the leftmost point. 
 
Follow Upper Surface <<< Right to Left <<< then Reverse: This mode 
starts at the rightmost point's upper surface, reverses at the leftmost point, 
and finishes back at the rightmost point. 
 
Follow Lower Surface >>> Left to Right >>> then Reverse: This mode 
starts at the leftmost point's lower surface, reverses at the rightmost point, 
and finishes back at the leftmost point. 
 
Follow Lower Surface <<< Right to Left <<< then Reverse: This mode 
starts at the rightmost point lower surface, reverses at the leftmost point, 
and finishes back at the rightmost point. 
 
 
Cyclic Reversal Method – graph digitizing options  
 
This option determines the method used for reversing at the turn around point 
when digitizing cyclic graphs. 
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Auto Reversal at Turn Around Point: This method automatically 
reverses the Line Follow Side and Direction when the turn around point is 
encountered, and then continues automatically. 
 
Pause at Turn Around Point: This method automatically reverses the 
Line Follow Side and Direction when the turn around point is encountered, 
and then pauses. 
 
 
Bar Graph Type – graph digitizing options  
 
This option allows you to select the type of bar graph to be digitized. 
UN-SCAN-IT gel only digitizes bar graphs that contain vertical bars. 
 
Upward Bars: This method follows the top surface of the bars in a vertical 
bar graph. 
Downward Bars: This method follows the bottom surface of the bars in a 
vertical bar graph. 
 
Up and Down Bars: This method follows the top surface of the bars when 
the bar value is above a user defined threshold, and the bottom surface 
when the bar value is below the user defined threshold. 
 
 

 
 
 
Dashed/Dotted Line Follow Method – graph digitizing options  
 
This option allows you to the select method used to follow a dashed/dotted 
line, and to select the vertical search window size used for the digitizing 
process. 
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Semi-Automatic - Interactive Vertical Limits: This method requires the 
user to guide the digitizing cursor and associated vertical limits along the 
data line as the data points are being automatically digitized. The Vertical 
Search Window setting determines the vertical limits of the search window 
in which data can be digitized. 
 
Automatic - Auto Estimating Vertical Limits: This method causes the 
software to automatically move the digitizing cursor and associated vertical 
limits as the data points are being automatically digitized. The Vertical 
Search Window setting determines the vertical limits of the search window 
in which data can be digitized. 
 
 
Contour Line Follow Method – graph digitizing options  
 
This option allows you to select method used to follow a contour line, and to 
select the vertical search window size used for the digitizing process. 
 
Semi-Automatic - Interactive Vertical Limits: This method requires the 
user to guide the digitizing cursor and associated vertical limits along the 
data line as the data points are being automatically digitized. The Vertical 
Search Window setting determines the vertical limits of the search window 
in which data can be digitized. 
 
Auto Estimating Vertical Limits with Auto Pause: This method 
automatically moves the cursor and vertical limits while automatically 
digitizing. Encountering a data gap pauses the software. The Vertical 
Search Window setting determines the vertical limits of the search window 
in which data can be digitized. 
 
 
Raster Scan Direction – graph digitizing options  
 
This option determines the starting point and scan direction used in raster scan 
digitizing. 
 
Lower Left Corner to Upper Right Corner: This method begins 
digitizing at the lower left corner of the raster scan region, and digitizes 
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points as the crosshair moves upward and then to the right though each 
column of pixels in the digitizing region. 
 
Upper Left Corner to Lower Right Corner: This method begins 
digitizing at the upper left corner of the scan region, and digitizes points as 
the crosshair moves downward and then to the right though each column of 
pixels in the digitizing region. 
 
Lower Right Corner to Upper Left Corner: This method begins 
digitizing at the lower right corner of the scan region, and digitizes points 
as the crosshair moves upward and then to the left though each column of 
pixels in the digitizing region. 
 
Upper Right Corner to Lower Left Corner: This method begins 
digitizing at the upper right corner of the scan region, and digitizes points 
as the crosshair moves downward and then to the left though each column 
of pixels in the digitizing region. 
 
 
Manual Point Assignment Method – graph digitizing options  
 
This option determines the method used to digitize points when using 
UN-SCAN-IT gel in Manual Mode (Digitizing Tablet Mode). 
 
Crosshair Position (Single Point Click): This method digitizes one single 
(x,y) point at the current crosshair position each time the space bar (or right 
mouse button) is pressed. 
 
Crosshair Position (Multi-Point Drag): This method digitizes multiple 
(x,y) points as the right mouse button is pressed and the mouse cursor is 
dragged. 
 
Center of Gravity (Symbol): Pressing the space bar (or right mouse 
button) digitizes one single (x,y) point which represents the average data 
pixel location within a raster scan box. The Search Window setting 
determines the size of the raster search window box to be used for 
extracting the Center of Gravity data value. 
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Automatic X Increments (Manual Mode) – graph digitizing options  
 
This option determines whether the manual digitizing crosshair will 
automatically increment in the X direction after each point is digitized in 
Manual Mode (Digitizing Tablet Mode). 
 
On: This method increments the manual digitizing crosshair one resolution 
unit in the current direction after each point is manually digitized. 
 
Off: This method causes the manual digitizing crosshair to remain at the 
current location after each point is manually digitized. 
 
 
Angle Units – graph digitizing options  
 
This option determines the whether a polar graph will be digitized using 
degree units or radians. 
 
Degrees (0-360): This selection will digitize the chart in standard degrees 
with a required range of 0 to 360 degrees. 
 
Radians (0-2pi): This selection will digitize the chart in radians with a 
required range of 0 to 2 pi radians. 
 
 
6.6  Digitizing Screen 
 
After the setup options have been selected, the main digitizing screen will 
appear. The main digitizing screen displays the entire image, either 
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maintaining the aspect ratio or stretched to fit within the resizable main 
window (depending on the Main Image View selected). A crosshair 
magnification window in the upper right corner displays a full scanner 
resolution view of the region surrounding the digitizing crosshair (use this 
window for fine adjustment of the crosshair position in order to maximize 
accuracy during the setup procedure). A grid on the right side of the digitizing 
screen displays the Setup Icon positions and values. A text box at the bottom 
of the screen provides instructions that guide the user through the digitizing 
setup process. 
 
 

 
 
 
The main menu that appears at the top of the digitizing screen contains the 
following menus: 
 
 Options Use this menu to adjust digitizing resolutions, change line 

following direction, change speeds, save the digitized data, 
etc. These options will be discussed later in this chapter. 

 
 Delete  Select Delete to sequentially delete the most recently 

digitized point(s). 
 
 Pause The Pause menu is only visible during the automatic 
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digitizing process. The automatic digitizing process can be 
paused at any point by selecting Pause menu option, or by 
selecting the Pause button. When automatic digitizing is 
paused, the software will temporarily switch to Manual 
Mode, allowing the graphics crosshair to be repositioned, 
points added, points deleted, digitizing options changed, 
etc. 

 
 Help Select Help to display help topics relating to the setup, 

options, or general digitizing process. In addition, the 
customer support contact information is available from the 
Help menu. 

 
 Exit   Select Exit to exit the digitizing process and go to the Main 

Menu, or to exit the digitizing process and go to the 
Graphing Screen (only available after points have been 
digitized). 

 
 
Options – digitizing screen 
 
By selecting the Options menu, many of the default and previously selected 
digitizing options can be modified, and other additional functions performed. 
The options available will depend on the Graph Digitizing Mode selected 
earlier in the digitizing process. The Options menu may include many of the 
following options: 
 
Point Assign Method Select this option to change the point assignment 

method used during automatic digitizing. Details 
regarding the different point assignment methods 
can be found in the Graph Digitizing Options 
portion of this manual. 

 
Manual Point Assign Use this option to change the method used for 

determining the digitized point location in manual 
mode. Details regarding the different manual point 
assignment methods can be found in the Graph 
Digitizing Options portion of this manual. 
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Bar Graph Type  Use this option to change the bar graph type 

setting used for digitizing. The bar graph type 
only applies to vertical bar graphs (horizontal bar 
graphs cannot be digitized with these methods). 
Details regarding the different bar graph type 
options can be found in the Graph Digitizing 
Options portion of this manual. 

 
Line Follow Side  Use this option to change the current line follow 

side used for automatic digitizing. Details 
regarding the different line follow side options can 
be found in the Graph Digitizing Options portion 
of this manual. 

 
Line Follow Direction Use this option to change the current line follow 

direction used for digitizing. Details regarding the 
different line follow direction options can be 
found in the Graph Digitizing Options portion of 
this manual. 

 
Automatic X Increment Use this option to change the current automatic x 

increments setting. Using automatic x increments 
can be useful when manually digitizing a 
continuous curve. Details regarding the different 
automatic x increment options can be found in the 
Graph Digitizing Options portion of this manual. 

 
Change Side and Dir Use this option to reverse both the line follow side 

and line follow direction simultaneously. Details 
regarding the different line side and line direction 
options can be found in the Graph Digitizing 
Options portion of this manual. 

 
Clear Pause Bars  Use this option to clear the positions of 

all the current pause bars used for digitizing 
intersecting curves. 
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Set Digitizing Speed Use this option to change the current digitizing 
speed used for automatic digitizing. Slowing the 
digitizing speed can be useful for allowing easier 
user interaction with the digitizing process. Details 
regarding the different digitizing speed options 
can be found in the Graph Digitizing Options 
portion of this manual. 

 
Set Main Image View Use this option to change the current main image 

view to either Maintain Aspect Ratio or Stretch to 
Fit. This option can also be used to set the zoom 
level and increase the size of the image within the 
viewing area. Note: Automatic Digitizing may be 
slower while image is zoomed. 

 
Set Digitizing Resolution Use this option to change the current digitizing 

resolution used by the software. The default 
resolution is 1 scanner unit. The resolution can be 
set anywhere from 1 to 10 scanner units. The 
resolution will directly affect the number of data 
points digitized (e.g. a 10 inch long curve scanned 
at 300 dpi will produce 3000 data points when 
digitized at a resolution of 1 scanner unit). 
Generally the most useful method for adjusting 
resolution is to digitize the image using a 
resolution setting of 1. Then later use the Adjust 
X Data Spacing option in the main graphing 
screen to fit a cubic spline curve to the data and 
adjust the x spacing. 

 
Set Eraser/Shifter Size Use this option to change the size of the 

UN-SCAN-IT gel digitized data eraser, and the 
vertical data shifter. The eraser can be useful for 
deleting stray points that were erroneously 
digitized during the automatic digitizing process. 
The vertical data shifter can be useful for 
adjusting the vertical position of selected 
digitized data points.  
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Set Vert Search Window Use this option to change the size of the vertical 

search window used by the software for following 
dashed/dotted graphs or contour plots. This setting 
determines the vertical limits beyond which the 
software will not search for data. Properly setting 
this limit will allow the software to remain on the 
curve of interest without jumping to another curve 
or skipping data. 

 
Set Sym Search Window Use this option to change the size of the symbol 

search window used by the software in manual 
mode (symbols). This setting determines the 
square size of the raster region in which the 
software will average the data pixels to determine 
a single data value. 

 
Set Data Line Color Use this option to change/set the current pixel 

color that the software accepts as data. This option 
is useful for selecting a particular colored data line 
to digitize among multiple colored curves. 

 
Set Screen Colors  Use this option to change the current 

screen colors and graphic options used by the 
software. The crosshair color, digitized point 
color, and digitized point size can be adjusted. 
Setting these display options can be useful in 
making the digitizing crosshair and data points 
more visible on the digitizing screen. 

 
Relocate Setup Icons Use this option to reposition any of the setup icons 

to new locations. This feature can be useful for 
redefining the data line color, setting new axis 
values, etc.  

 
Slide All Axis Setup Icons Use this option to move all the current setup icons 

and their corresponding location settings in the 
desired direction. This feature can be especially 
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useful when used in conjunction with the 
Save/Load Axis Setup Parameters option. By 
using these options, multiple graphs with similar 
axis parameters can be easily digitized by simply 
saving and loading the axis setup parameters, and 
then sliding the axis setup icons to account for 
shifts that may have occurred during the scanning 
process. 

 
Current Settings & Info Use this option to display the current digitizing 

and setup options that have been selected, as well 
as some general information regarding the current 
image. 

 
Copy Screen Image Use this option to Copy the current digitizing 

Screen Image to the Clipboard. The screen 
image can then be Pasted into another program 
(word processor, graphics, etc.). 

 
Adjust X Data Spacing The digitizing process converts scanner pixel 

units into user defined scaled units. The resulting 
X data spacing may appear arbitrary as a result 
of this conversion. However, the X data spacing 
can be adjusted by fitting the digitized data 
points using a cubic spline or linear fit. To 
Adjust X Data Spacing, go to the Graphing 
Screen. 

 
Save Current (x,y) Data Use this option to save the current digitized (x,y) 

data to a standard data file (or the Windows 
clipboard). The saved data file can then be read 
into other programs, such as spreadsheet, data 
analysis, or graphics software. 

 
Clear Current (x,y) Data Use this option to clear the current digitized (x,y) 

data from memory. This option is useful for 
clearing data that has been saved, and then 
digitizing additional data on the same image. 
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Clearing data can also be useful for deleting 
erroneous data before returning to the digitizing 
process. 

 
Save Axis Setup Param Use this option to save the current axis setup 

parameters (Xmin, Xmax, Begin, End, etc.). This 
option can be very useful for saving and 
retrieving the setup icon positions and values in 
order to digitize the current image or another 
similar image at a later time, without having to 
re-define all of the setup icon positions and 
values. 

 
Load Axis Setup Param Use this option to load previously saved axis 

setup parameters (Xmin, Xmax, Begin, End, 
etc.). This option can be very useful for 
retrieving previously saved setup icon positions 
and values in order to re-digitize a previous 
image or digitize another similar image, without 
having to re-define all of the setup icon positions 
and values. 

 
 
6.7  Positioning the Setup Icons 
 
This section will assist you in positioning the setup icons at their appropriate 
locations on the graphical image. All of the required Setup Icons must be 
dragged to their corresponding graphical locations before digitizing can 
begin. The pending required Setup Icons are indicated with a gray arrow 
beside the icon, and can be found along the bottom edge of the main 
digitizing window. The accuracy of the digitized data will depend directly 
upon the precision with which the setup icons are located on the image. 
 
 
Icon and Crosshair Movement – positioning the setup icons 
 
The setup icons can be dragged to their proper locations by clicking and 
holding the left mouse button while dragging the setup icon to the desired 
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location (the hot spot on the setup icon will be shown with a digitizing 
crosshair). Fine icon movements can be achieved by pressing the keyboard 
arrow (or Ctrl+arrow) keys while the left mouse button remains depressed on 
the setup icon. Use the crosshair magnification in the upper right corner of the 
digitizing screen for precise alignment. 
 
 
Data Color – positioning the setup icons 
 
If Black and White, Grayscale, or Color was the color type selected, then 
move the Color Icon so that it is exactly over the data line you wish to 
digitize. Use the crosshair magnification window in the upper right corner of 
the digitizing screen for precise alignment. The color selected will be 
displayed in the grid at the right side of the screen. This step identifies the data 
line color that UN-SCAN-IT gel will accept as data. 
  
If Digitize All Colors Except Background was the color type selected, then 
move the Color Icon so that it is exactly over the background color that 
UN-SCAN-IT gel will ignore and not accept as data. Use the crosshair 
magnification window in the upper right corner of the digitizing screen for 
precise alignment. The background color selected will be displayed in the grid 
at the right side of the screen. This step identifies the background color that 
UN-SCAN-IT gel will ignore and not accept as data.  
 
Grid Line Color - If the Line Intensity (Grayscale) grid line filter has been 
selected, the Grid Line Color must be also identified. Move the Grid Icon so 
that it is exactly over a major grid line. Use the crosshair magnification in the 
upper right corner of the digitizing screen for precise alignment. The grid line 
color selected will be displayed in the grid at the right side of the screen. This 
identifies the grid line intensity. 
 
Note: Incorrectly identifying the data (or background) color will result in 
errors during the digitizing process. 
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Locating Axis Scaling Points – positioning the setup icons 
 
Cartesian (x,y) Coordinates 
 
Xmin: Move the X min Icon so that it is exactly over the lowest (leftmost) 
X axis scaling mark. The X min Icon should be located on a scaling mark 
where the X value is known (not on the data line where the X value is not 
known). Use the crosshair magnification in the upper right corner of the 
digitizing screen for precise alignment. Incorrectly identifying the scaling 
marks will result in errors in the digitized data. The X min Icon should 
generally be placed over the center of the scaling mark for best precision 
and accuracy. 
 
Xmax: Move the X max Icon so that it is exactly over the highest 
(rightmost) X axis scaling mark. The X max Icon should be located on a 
scaling mark where the X value is known (not on the data line where the X 
value is not known). Use the crosshair magnification in the upper right 
corner of the digitizing screen for precise alignment. Incorrectly identifying 
the scaling marks will result in errors in the digitized data. The X max Icon 
should generally be placed over the center of the scaling mark for best 
precision and accuracy. 
 
Ymin: Move the Y min Icon so that it is exactly over the lowest (bottom) Y 
axis scaling mark. The Y min Icon should be located on a scaling mark 
where the Y value is known (not on the data line where the Y value is not 
known). Use the crosshair magnification in the upper right corner of the 
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digitizing screen for precise alignment. Incorrectly identifying the scaling 
marks will result in errors in the digitized data. The Y min Icon should 
generally be placed over the center of the scaling mark for best precision 
and accuracy. 
 
Ymax: Move the Y max Icon so that it is exactly over the highest (top) Y 
axis scaling mark. The Y max Icon should be located on a scaling mark 
where the Y value is known (not on the data line where the Y value is not 
known). Use the crosshair magnification in the upper right corner of the 
digitizing screen for precise alignment. Incorrectly identifying the scaling 
marks will result in errors in the digitized data. The Y max Icon should 
generally be placed over the center of the scaling mark for best precision 
and accuracy." 
 

 
 
Note: It is important to be consistent in locating the positions of the tick 
marks (e.g. always use the center of the tick mark when defining the axes 
points). Careful attention to defining the axes scaling points is critical for 
obtaining accurate digitizing results. 
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Polar (r,theta) Coordinates 
 
Origin: Move the Origin Icon so that it is exactly over the origin (r=0, theta 
= 0 of the polar coordinate system. Use the crosshair magnification in the 
upper right corner of the digitizing screen for precise alignment. Incorrectly 
identifying the scaling marks will result in errors in the digitized data. 
 
(r, theta): Move the (r, theta) Icon so that it is exactly over an axis point or 
a data point where the (r, theta) value is known. Use the crosshair 
magnification in the upper right corner of the digitizing screen for precise 
alignment. Incorrectly identifying the scaling marks will result in errors in 
the digitized data. Scaling points with horizontal and vertical components 
of the (r, theta) location will be required for proper scaling. 
 

 
 
 
Numerical Values - After defining each axis location, UN-SCAN-IT gel will 
prompt you to enter the numerical value corresponding to that particular 
scaling mark. 
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Tilt Correction: Based upon the difference in the vertical pixel locations 
and the difference in the horizontal pixel locations at the Xmin and Xmax 
setup icons, UN-SCAN-IT gel will determine if the graph is tilted. If the 
graph is tilted, UN-SCAN-IT gel will determine the tilt angle and allow the 
user to choose to correct the data values. Although the software will correct 
the digitized data for graphs that are slightly tilted, graphs that are tilted 
more than 5 degrees may cause errors in the digitized data, and should be 
scanned again (or rotated to the proper alignment using your scanner or 
image processing software). Although UN-SCAN-IT gel will correct for 
tilted graphs, graphs that have no tilt or a very small tilt will product the 
most accurate and symmetric digitized data. The axis lines must be 
orthogonal (i.e. at right angles to each other) to obtain accurate results. 
 

 
 
 

Chapter 6: Digitizing (x,y) Graphs  83 



 

Locating Beginning Point – positioning the setup icons 
 
Automatic Line Follow Modes 
 
Begin: Move the Begin Icon to the location where you wish the digitizing 
process to begin. If the current Line Follow Direction is >>> Left to Right 
>>>, the Begin Icon should be located at the leftmost point to digitize. If 
the current Line Follow Direction is <<< Right to Left <<<, the Begin Icon 
should be located at rightmost point to digitize. 
 

 
 
 
Raster Scan Modes 
 
Raster Upper Limit: Move the Upper Right Icon to the upper right corner 
of the area you wish to raster scan. The Upper Right Icon should be 
vertically located slightly ABOVE the highest point to be raster scanned, 
and horizontally located slightly to the RIGHT of the rightmost point to be 
raster scanned. 
 
Raster Lower Limit: Move the Lower Left Icon to the lower left corner of 
the area you wish to raster scan. The Lower Left Icon should be vertically 
located slightly BELOW the lowest point to be raster scanned, and 
horizontally located slightly to the LEFT of the leftmost point to be raster 
scanned. 
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Defining Vertical Limits – positioning the setup icons 
 
Defining the vertical limits prevents the system from accepting or searching 
for data outside the specified vertical digitizing region. This feature speeds the 
digitizing process and reduces the possibility of finding extraneous data or 
following axes lines. 
 
Automatic Line Follow Modes 
 
Upper Vertical Limit: Move the Upper Limit Icon to a vertical location 
slightly ABOVE the highest vertical point on the data curve. This step sets 
the upper vertical limit beyond which UN-SCAN-IT gel will not search. 
Setting the Upper Limit Icon too high may allow the software to 
erroneously follow another data line or the upper axis line. Setting the 
Upper Limit Icon too low will cause the software to erroneously ignore the 
data line above that limit. 
 
Lower Vertical Limit: Move the Lower Limit Icon to a vertical location 
slightly BELOW the lowest vertical point on the data curve. This step sets 
the lower vertical limit beyond which UN-SCAN-IT gel will not search. 
Setting the Lower Limit Icon too low may allow the software to 
erroneously follow another data line or the lower axis line. Setting the 
Lower Limit Icon too high will cause the software to erroneously ignore the 
data line below that limit. 
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Flat Spot / Line Thickness – positioning the setup icons 
 
Automatic Line Follow Modes 
 
Flat Spot: Move the Flat Spot Icon to a vertical location slightly ABOVE a 
relatively flat portion of the data line. This step is used to measure the flat 
line thickness of the data curve, in order to best estimate the location of the 
middle of the data line during digitizing. The Flat Spot Icon should be 
located above the data line that matches the selected Data Line Color. 
Locating the Flat Spot Icon over a steep portion of the data line will cause 
the measured line thickness to be too large and will result in a vertical shift 
error in the digitized data. If there is no flat portion of the data line 
available, the Flat Spot icon can be placed above a flat portion of any 
horizontal line of similar thickness and color as the data line. To disable or 
re-enable the line thickness correction, press the Esc key while positioning 
the Flat Spot Icon. 
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Locating Ending Point – positioning the setup icons 
 
Automatic Line Follow Modes 
 
End: Move the End Icon to the location where you wish the digitizing 
process to end. If the current Line Follow Direction is >>> Left to Right 
>>>, the End Icon should be located at the rightmost point to digitize. If the 
current Line Follow Direction is <<< Right to Left <<<, the End Icon 
should be located on leftmost point to digitize. 
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Variable Surface – positioning the setup icons 
 
Automatic Line Follow Modes 
 
Variable Surface: If Variable Surface of Line was selected, then position 
the Line Side Divider Icon (red and blue icon with arrows) where the 
software should automatically switch Line Follow Sides. The software will 
follow the Upper Surface of the line when it is above this icon, and the 
Lower Surface of the line when it is below this icon. 
 

 
 
 
Pause Bars – positioning the setup icons 
 
Intersecting Line Follow Mode 
 
Pause Bars: If Manual Pause Bars was selected, then move the Pause Icon 
so that it is exactly over the point on the data line where the software should 
pause during the automatic line following process. A maximum of 10 pause 
bars can be inserted. Automatic digitizing can also be paused (and then 
resumed) at any time by selecting the Pause button during automatic 
digitizing. 
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6.8  Digitizing Modes 
 
The process in which the image is digitized depends upon which Graph 
Digitizing Mode was selected during the digitizing setup process. 
 
Automatic Line Follow Modes - digitizing modes 
 
After all of the setup icons have been positioned and digitizing has begun, a 
graphics crosshair will appear on the image. As the crosshair follows the data 
line, the current number of data points digitized (N:), the x value of the most 
recent digitized point (X:), and the y value of the most recent digitized point 
(Y:) will be displayed at the bottom of the screen. These values will also be 
stored and displayed in the data spreadsheet at the right side of the digitizing 
screen. 
 
The crosshair will automatically follow along the data line being digitized, 
and will move in the current line follow direction as each digitized data point 
is assigned. The digitized data points will appear graphically as colored dots 
along the data line, and theses dots can be used to gauge the accuracy of the 
digitized data. The color and size of the dots can be changed in the Set Screen 
Colors portion of the Options menu. 
 
The digitizing process can be paused at any point by selecting the Pause 
button (or by pressing Enter). The software will temporarily switch to 
Manual Mode. In Manual Mode the graphics crosshair to be repositioned, 
points added, points deleted, digitizing options changed, etc. Select Continue 
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to resume automatic line follow digitizing. 
 
If the crosshair is moving too quickly along the data line, the digitizing 
process can be slowed by selecting Set Digitizing Speed in the Options menu 
 
The digitizing process can be discontinued at any time by selecting Exit. 
 
Upon completion of the digitizing process, a window will appear that will 
prompt you regarding the digitized data.  
 
Accept the Data Points and Return to Digitizing Screen: Choose this 
option if the digitized data points appeared acceptable and you wish to save, 
view, erase, shift, or digitize additional data points on the graph. 
 
Accept the Data Points and Go To Graphing Screen: Choose this option if 
the digitized data points appeared acceptable and you wish to go directly to 
the Graphing Screen where you can edit, sort, smooth, integrate areas, etc. 
(see the Graphing / Modifying (x,y) Data chapter for details).  
 
Do not Accept the Data Points and Return to Digitizing Screen: Choose 
this option if the digitized data points are not acceptable, and you wish to 
return to the Digitizing Screen and adjust the setup icons, change digitizing 
options, or exit the digitizing process. 
 
 
Raster Scan Modes - digitizing modes 
 
After all of the setup icons have been positioned and digitizing has begun, a 
graphics crosshair will appear on the image. As the crosshair moves through 
the region being raster scanned, the current number of data points digitized 
(N:), the x value of the most recent digitized point (X:), and the y value of the 
most recent digitized point (Y:) will be displayed at the bottom of the screen. 
These values will also be stored and displayed in the data spreadsheet at the 
right side of the digitizing screen. 
 
The digitized data points will appear graphically as colored dots overlapping 
each data point. The color and size of the dots can be changed in the Set 
Screen Colors portion of the Options menu. 
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The digitizing process can be paused at any point by selecting Pause (or by 
pressing Enter). The software will temporarily switch to Manual Mode. In 
Manual Mode the graphics crosshair to be repositioned, points added, points 
deleted, digitizing options changed, etc. Select Continue to resume raster 
scan digitizing. 
 
If the crosshair is moving too quickly throughout the data, the digitizing 
process can be slowed by selecting Set Digitizing Speed in the Options menu 
 
The digitizing process can be discontinued at any time by selecting Exit. 
 
Upon completion of the digitizing process, a window will appear that will 
prompt you regarding the digitized data.  
 
Accept the Data Points and Return to Digitizing Screen: Choose this 
option if the digitized data points appeared acceptable and you wish to save, 
view, erase, shift, or digitize additional data points on the graph. 
 
Accept the Data Points and Go To Graphing Screen: Choose this option if 
the digitized data points appeared acceptable and you wish to go to the 
Graphing Screen where you can edit, sort, smooth, integrate areas, etc. (see 
the Graphing / Modifing (x,y) Data chapter for details).  
 
Do not Accept the Data Points and Return to Digitizing Screen: Choose 
this option if the digitized data points are not acceptable, and you wish to 
return to the Digitizing Screen and adjust the setup icons, change digitizing 
options, or exit the digitizing process. 
 
 
Manual Modes - digitizing modes 
 
After all of the setup icons have been positioned and digitizing has begun, a 
graphics crosshair will appear on the image. The current number of data 
points digitized (N:), the current x position of the graphics crosshair (X:), and 
the current y position of the graphics crosshair (Y:) will be displayed at the 
bottom of the screen (if digitizing in polar coordinates, the r and theta 
coordinates will be displayed). These values will also be stored and displayed 
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in the data spreadsheet at the right side of the digitizing screen. 
 
The crosshair can be positioned using the left mouse button, the keyboard 
arrow keys for fine movement, or the Ctrl + arrow keys for coarse 
movements. As each point is digitized, a colored dot will appear at that 
position. The color and size of the dots can be changed in the Set Screen 
Colors portion of the Options menu. 
 
The digitizing process can be discontinued at any time by selecting Exit. 
 
Crosshair Position Mode - Press the Space Bar (or right mouse button) to 
digitize the point currently located at the graphics crosshair. Use the crosshair 
magnification window in upper right corner of the screen for precise crosshair 
alignment. If Automatic X Increments were selected in the Options menu, 
the graphics crosshair will increment automatically along the x-axis after each 
point is digitized. To delete the most recently digitized point(s) select Delete. 
 
Center of Gravity (Symbol) Mode - Press the Space Bar (or right mouse 
button) to digitize the point or symbol within the raster scan region of the 
crosshair (this raster region is indicated by a box around the center of the 
crosshair). Use the crosshair magnification window in upper right corner of 
the screen for precise crosshair alignment. The software will raster scan the 
search region, find the average location of the digitized pixels in that region, 
and assign a single digitized value based upon that average. To delete the 
most recently digitized point(s) select Delete.  
 
 
6.9  Erasing Digitized Data Points 
 
Stray marks, other data lines, axes lines, symbols, etc. may occasionally be 
incorrectly identified as data points during the digitizing process. A data 
eraser can be activated by selecting the Erase Data button near the bottom of 
the digitizing screen. Position the data eraser box over the data points you 
wish to delete, and press the left mouse button to delete the underlying data 
points from memory and the digitizing screen. The data eraser size can be 
modified by selecting Set Data Eraser Size in the Options menu. Press Esc 
to exit the data erasing mode, and return to the digitizing mode. 
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6.10  Shifting Data Vertically 
 
It may be useful to adjust the vertical positions of selected digitized data 
points after they have been digitized. The Vertical Data Shifter can be 
activated by selecting the data shifter button from the digitizing toolbar. 
Position the Shift Data box over the points to shift. Pressing the left mouse 
button will shift the points and their values down. Pressing the right mouse 
button will shift the points and their values up. The data shifter size can be 
modified by selecting Set Data Shifter Size in the Options menu. Press Esc 
to exit the shift data mode, and return to the digitizing mode. 
 
 
6.11  Adjusting the X Spacing of the Data 
 
When digitizing images the inherent image resolution is usually sufficient to 
produce excellent digitizing results. However, you may wish to increase, 
decrease or modify the X Data Spacing between the data points to a user 
specified value (this will allow multiple curves to have the same x-spacing 
and be graphed simultaneously using other graphing software). This feature 
can also the user to define a set number of digitized data points with user 
defined spacing. To modify the x spacing of the digitized data, you may wish 
to use the Adjust X Data Spacing feature available in UN-SCAN-IT gel. To 
access this feature, go to the Graphing Screen. For details regarding the use of 
the Adjust X Data Spacing feature, refer to the Graphing / Modifying (x,y) 
Data chapter. 
 
 
6.12  Exporting the Digitized Data to Other Software 
 
The primary purpose of the UN-SCAN-IT gel software is to extract the 
underlying (x,y) values from graphical images. Once the digitizing process is 
complete, the extracted data can be exported to other software by either 
saving the (x,y) data as an ASCII Text data file, or copying the (x,y) data 
directly to the Windows Clipboard and pasting the data into the desired 
software. These File options are discussed later in this manual. 
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 Chapter 7 
 
 GRAPHING / MODIFYING (X,Y) DATA 
 
 
7.1  Overview 
 
This chapter will guide you through the different Graphing options present in 
the UN-SCAN-IT gel software. The graphing options allow you to 
graphically view, edit, and analyze the digitized data. Additionally, the (x,y) 
data can be exported to other graphing or spreadsheet software for analysis. 
 
Many of the UN-SCAN-IT gel graphing menu options can also be accessed 
from the toolbar located below the graphing menus. The Help menus may be 
used to provide helpful information regarding the graphing options and 
buttons. 
 
 
7.2  Main Menu 
 
To enter the Graph portion of the UN-SCAN-IT gel program from the main 
menu select: 
 
 Graph Data 
 
Graph / Modify (x,y) Data - main menu 
 
Select Graph / Modify (x,y) Data... to graphically view and modify the (x,y) 
digitized data. 
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7.3  Cursor Movement 
 
The UN-SCAN-IT gel Graphics Screen is equipped with two interactive 
cursors (small vertical lines). These left and right cursors can be used for data 
identification, modification, and analysis. 
 
The Left Cursor or Right Cursor can be activated by clicking the buttons at 
the bottom of the graph screen. The active cursor will blink, and have a 
checkmark displayed in the corresponding button at the bottom center of the 
graph. 
 
The active cursor can be moved by clicking the mouse at the desired 
horizontal position on the graph, clicking the arrow buttons at the bottom of 
the graph, using the keyboard arrow keys (Ctrl + arrow keys for larger 
movements), or by selecting the desired data point in the spreadsheet on the 
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left side of the screen. 
 
The x and y values of the data point at the active cursor are highlighted in the 
spreadsheet on the left side of the screen. 
 
If you have any difficulty using or moving the cursors, you may wish to click 
the Sort button to sort the data into ascending or descending array order. The 
Left Cursor and Right Cursors cannot cross each other (in array order), so 
data arrays that are not sorted may prevent proper movement of the graphic 
cursors. 
 
 
7.4  Graph Options 
 
After the graph is displayed on screen, an Options menu will be available that 
contains useful graphical options and features: 
 
 
Undo Delete Select Undo Most Recent Point Delete to restore the most 

recent data point that has been deleted. 
 
Draw Points Select Draw Points to display the (x,y) data points as dots 

on the screen. The data point size can be set using the Set 
Graph Colors option.  

 
Draw Lines Select Draw Lines to connect the (x,y) data points with 

straight lines. If the data are not sorted, the lines may 
appear to be connected in a haphazard manner, and you 
may wish to sort the data. The data line size can be set 
using the Set Graph Colors option. 

 
Points & Lines Select Draw Points and Lines to display the (xy) data 

points as dots connected with straight lines. If the data are 
not sorted, the lines may appear to be connected in a 
haphazard manner, and you may wish to sort the data. The 
data point and line size can be set using the Set Graph 
Colors option. 
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X Direction Select X Direction... Low to High to scale the graph with 
the lowest x values on the left and highest x values on the 
right. Select X Direction... High to Low to scale the graph 
with the highest x values on the left and lowest x values on 
the right. 

 
Y Direction Select Y Direction... Low to High to scale the graph with 

the lowest y values on the bottom and highest y values on 
the top. Select Y Direction... High to Low to scale the 
graph with the highest y values on the bottom and lowest y 
values on the top. 

 
Set Scale Select Set Scale… to manually choose the x and y scales 

used to display the graph. Full Scale is defined such that all 
of the data points will appear on the graph. Linear, log, and 
semi-log scales can be selected. 

 
X Data Spacing Select Adjust X Data Spacing... to adjust the x data 

spacing by fitting the data with either a cubic spline or 
linear fit. A window will appear with several options. Enter 
the data range to be adjusted and the desired x increments. 
Xmin cannot be less than the lowest x data point, and 
Xmax cannot be greater than the highest x data point. The 
X Increment is the desired spacing (in user units) between 
adjusted x points. The New # of Points represents the 
number of data points after the adjustment is performed. 
You may select a Cubic Spline fit or Linear fit for the 
digitized data points. The original and adjusted data will be 
displayed on screen, and you will be prompted to replace 
the original data with the adjusted data or retain the original 
data. This feature is useful for aligning x spacing in order 
to graph multiple curves on the same scale using other 
graphing software or to set x data points to exact user 
specified values. This feature can also be used allow to 
user to define a set number of digitized data points. 

  
Graph Colors Select Set Graph Colors... to change the background 

color, data point color, data line color, cursor color, 
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highlight point color, highlight line color, data point size, 
and data line size. 

 
Set Eraser Size Select Set Data Eraser and Data Shifter Size... to change 

the size of the graphical data eraser . This eraser can be 
useful for deleting stray points that were obtained during 
the automatic digitizing process. 

  
Edit/Ins Mode Select Edit/Insert Mode… Keyboard to use the keyboard 

to edit or insert data points on the graph when the Edit or 
Insert button has been selected. Select Edit/Insert 
Mode… Mouse to use the mouse for point and click 
editing and insertion of data points when the Edit or Insert 
button has been selected. 

 
Temporary File Select Temporary File… Add Current Data Point to add 

the data point at the active cursor (or Area value if area is 
highlighted) to the temporary file. Select Temporary 
File… Clear Temporary File to erase all the data values 
in the temporary file. Select Temporary File… Copy 
Temporary Data to Clipboard to copy all the data in the 
temporary file to the clipboard and allow the data to be 
pasted into another program (spreadsheet, word processor, 
etc.). These options are useful for extracting just a few 
selected data points or area values from the graph. 

 
Screen Image Select Copy Screen Image to Clipboard… to Copy the 

current digitizing Screen Image to the Clipboard. The 
screen image can then be Pasted into another program 
(word processor, graphics, etc.). 

 
Save (x,y) Data Select Save Data… to save the (x,y) data to a file. The 

current (x,y) data can be saved to a standard data file, or 
copied to the Windows clipboard. The data can then be 
read into other programs, such as spreadsheet, data 
analysis, or graphics software. 

 
Load (x,y) Data Select Load (x,y) Data… to load a previously digitized 
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(x,y) data file, or to load a standard (x,y) ASCII Text data 
file. The standard Windows dialog box will appear. 
Loading a file clears all digitized data presently in memory. 
The software can load data saved by UN-SCAN-IT gel; or 
standard comma or tab delimited (x,y) ASCII Text data 
saved by other programs. 

 
 
7.5  Graph Buttons 
 
After the graph is displayed on screen, a series of graph buttons will be 
displayed below the data spreadsheet and at the bottom of the graphing screen 
 
Edit Point - graph buttons 
The data point at the active cursor can be edited by selecting the Edit button. 
In Keyboard Edit Mode, the current x and y values at the active cursor will be 
displayed in the edit box. Edit these values to change the value of the selected 
point. In Mouse Edit Mode, simply click on the graph where you wish to 
locate the edited point. 
 
Insert Point - graph buttons 
A data point can be added to the data file and displayed on the screen by 
selecting the Insert button. In Keyboard Insert Mode, the current x and y 
values at the active cursor will be displayed in the insert box. Enter the x and 
y values of the new data point. In Mouse Insert Mode, simply click on the 
graph where you wish to locate the new point. 
 
Delete Point - graph buttons 
The data point at the active cursor can be deleted from the data file and erased 
from the graphing screen by selecting the Delete button. Select Undo Most 
Recent Point Delete from the Options menu to restore the most recently 
deleted data point. 
 
Erase Data - graph buttons 
The data eraser can be activated by selecting the Erase Data button. Position 
the data eraser box over the data points you wish to delete, and press the left 
mouse button to delete the underlying data points from memory and the 
graphing screen. The data eraser size can be modified by selecting Set Data 

100  UN-SCAN-IT gel User’s Manual 



 

Eraser Size in the Options menu. Press Esc to exit the data erasing mode, 
and return to  the regular graphing mode. 
 

 
 
 
 
Sort Data - graph buttons 
The entire (x,y) data array can be sorted into ascending or descending x order 
by selecting the Sort button. This option should be used when data have been 
added to the digitized file or some of the data points are not in increasing (or 
decreasing) x array order. Some of the cursor and graphing options may not 
work properly if the data are not properly sorted. 

 
Expand - graph buttons 
The region between the cursors can be expanded to fill the graphing screen by 
selecting the Expand button. To return to full scale, right click the Expand 
button (or use the Set Scale feature in the Options menu). 
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Area - graph buttons 
The area under the curve between the graphics cursors can be integrated by 
selecting the Area button. The UN-SCAN-IT gel software uses the 
trapezoidal rule to determine the area. The area (x units multiplied by y units) 
will be displayed in the upper right message box. The background selection 
for the area calculation is a straight line between the cursors, and can be 
modified by Inserting or Deleting data points, and locating the cursor on the 
new data point to calculate a new background. Press Esc to exit the area 
mode, and return to  the regular graphing mode. 
 
 

 
 
 
Adjust X Data Spacing - graph buttons 
The x data spacing of the data points can be adjusted by selecting the Adjust 
Spacing button.. A window will appear with several options. Enter the data 
range to be adjusted and the desired x increments. Xmin cannot be less than 
the lowest x data point, and Xmax cannot be greater than the highest x data 
point. The X Increment is the desired spacing (in user units) between adjusted 
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x points. The New # of Points represents the number of data points after the 
adjustment is performed. You may select a Cubic Spline fit or Linear fit for 
the digitized data points. The original and adjusted data will be displayed on 
screen, and you will be prompted to replace the original data with the adjusted 
data or retain the original data. 
 
This feature is useful for aligning x spacing in order to graph multiple 
curves on the same scale using other graphing software or to set x data 
points to exact user specified values. This feature can also allow the user to 
define a set number of digitized data points 
 
 
Smooth - graph buttons 
The entire (x,y) data set can be smoothed by selecting the Smooth button. The 
program will sort the data and then prompt you to select the number of points 
in the smoothing function, and the type of smooth to be performed. The 
n-point smooth is a standard boxcar averaging smooth, while the weighted 
smooth statistically prioritizes each data point in order to best retain the 
original peak height and shape. The original and smoothed data will be 
displayed on screen, and you will be prompted to replace the original data 
with the smoothed data., or retain the original data. 
 
 
Derivative - graph buttons 
A derivative of the entire (x,y) data sete can be obtained by selecting the 
Derivative button. The program will sort the data and then prompt you to 
select the number of points in the smoothed derivative operation, and to select 
the derivative type. The standard 1st derivative (dy/dx) is a standard 
derivative (with no smoothing), while the weighted derivative options 
statistically weights and smoothes the derivative data as it is processed. The 
original and derivative data will be displayed on screen, and you will be 
prompted to replace the original data with the derivative data, or retain the 
original data. 
 
 
Least Squares - graph buttons 
A least squares polynomial can be fit to the data by selecting the Least 
Squares button. You will be prompted to enter the order of fit for the least 
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squares equation. 
 
Select Average Value to obtain an average Y value for the data. 
(y = a) 
 
Select 1st Order Polynomial to obtain a linear line fit of the data. 
(y = a + bx) 
 
Select 2nd Order Polynomial to obtain a second order fit of the data. 
(y = a + bx + cx2) 
 
The original data and least squares fit will be displayed on screen, and the 
least squares constants and standard deviation will be displayed in the 
message box. 
 
 
7.6  Help  
 
Select Help to display help topics relating to the graphing options and 
buttons. In addition, the customer support contact information is available 
from the Help menu 
 
 
7.7  Exit  
 
Select Exit Graph to exit the graphing screen and return to the Main Menu, 
or to exit the graphing screen and return directly to the Digitizing Screen 
(only available if the graphing screen was accessed from the digitizing 
screen). 
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 Chapter 8 
 
 UN-SCAN-IT gel HELP 
 
 
8.1  Help Menu 
 
To enter the Help portion of the UN-SCAN-IT gel program from the main 
menu select: 
 
 Help 
 
 

 
 
 
8.2  Help 
 
Context sensitive help is available throughout the digitizing and graphing 
screens. If you have further questions or need assistance, please contact 
customer support. 
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8.3  Customer Support 
 
 Silk Scientific, Inc. 
 1060 Oakmont Lane  Provo, Utah 84604 USA 
 Tel: 1-801-377-6978   Fax: 1-801-228-2448 
 E-Mail: info@silkscientific.com 
 
 
8.4  Show Startup Screen 
 
Selecting this menu option will display the Startup Screen, and allow you to 
directly choose to Analyze a Gel, Digitize a Graph, or go to Main Menu 
whenever the program starts. 
 
 
8.5  About UN-SCAN-IT gel 
 
Selecting this menu option will display the current UN-SCAN-IT gel version 
number, Serial Number, and license holder. 
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 Appendix A 
 
 SCANNING AND MODIFYING THE IMAGE 
 
Overview 
 
The UN-SCAN-IT gel software imports standard image files from scanners, 
digital cameras, the internet, etc. These images should be obtained and 
modified using the hardware and software provided with these devices, or by 
using third party imaging software. The final image should be ‘right side up’ 
with the lanes in the vertical direction (gels), or the x-axis in the horizontal 
direction (graphs). The image should be saved in a standard image format (tif, 
jpg, png, bmp, gif, etc.). 
 
In addition, we have provided the Modify Image feature for your 
convenience. This feature provides some basic image modifying capabilities. 
To  Modify an image, select Scan/Modify Image… from the 
UN-SCAN-IT gel main File menu. 
 
File - scan/modify image 
 
Open   Select Open... to open an existing image file. 
 
Save   Select Save... to save the current image. 
 
Restore Original Image Select Restore Original Image to return the 

image to it’s unmodified state. 
 
 
Modify - scan/modify image 
 
Rotate   Select Rotate… to rotate the image to a new 

value. 
 
Color Depth  Select Color Depth… to adjust the color 

properties and bit-depth of the image. 
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Brightness  Select Brightness… to adjust the brightness of the 
image. 

 
Invert   Select Invert to invert the color of all pixels in the 

image.  
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 Appendix B 
 
 TROUBLESHOOTING FAQS (GEL ANALYSIS) 
 
 
Overview 
 
This appendix provides some possible solutions to questions that may be 
encountered while using the UN-SCAN-IT gel software to analyze gels. 
Please do not struggle with any technical issues that you may have regarding 
the use of this software, as we can often answer your question and solve your 
problem. Please note that the customer support information listed below can 
also be displayed from within the software by accessing the main Help menu. 
 
Customer Support: 
  Silk Scientific 
  1060 Oakmont Lane  Provo, Utah 84604 USA 
  Tel: 1-801-377-6978   Fax: 1-801-228-2448 
  E-Mail: info@silkscientific.com  
 
 
Question: Is there a way to get the image to load and digitize faster? 
 
Answer(s): 
 
•  Try scanning and saving the image at a lower dpi (dots per inch) 

resolution from within your scanning software. 
•  If you are loading the image file from a disk, copy the file to the hard 

drive, and load the image file from the hard drive. 
• Move the software onto a faster computer with more memory. 
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Question: What could prevent UN-SCAN-IT gel from reading the 
image? 
 
Answer(s): 
 
• Make sure you are loading the image file from the Analyze Gel menu and 

not the File/Load menu. 
• Make sure the file was saved in a standard scanner format accepted by 

UN-SCAN-IT gel (e.g. .jpg, .tif, .bmp, etc.). 
• Try reading the image file on a different computer to make sure that it is 

not a hardware problem unique to your computer. 
 
Question: Does UN-SCAN-IT gel analyze PDF files? 
 
Answer: 
 
• UN-SCAN-IT gel does not currently accept PDF files. PDF files often 
contain multiple pages, imbedded text, and variable dpi settings, which can 
present difficulties in extracting accurate and useful digitized data. PDF files 
should be converted to a standard image format (tif, jpg, bmp, png, etc) before 
loading into UN-SCAN-IT gel. 
 
 
Question: Why does the image appear stretched or distorted in the Main 
Window? 
 
Answer: 
 
• If the Stretch to Fit option was selected, the entire image is scaled to fit 

within the main analysis window. Any stretching of the image is to allow 
the entire image to fit in the within the main window (this apparent 
stretching will not affect the analyzed data). If you would like to reduce 
the stretching in the main window, you can either resize the 
UN-SCAN-IT gel main window to dimensions more similar to the 
original image, or select the Maintain Aspect Ratio option to preserve the 
original image width to height ratio when displaying the image in the 
main digitizing windows. 
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Question: Why does the gel image appear very small in the Crosshair 
Magnification Window? 
 
Answer: 
 
• The crosshair Magnification Window displays any portion (or all ) of the 

image at full scanner resolution. If this image is small, it was probably 
scanned at a low resolution, and should be scanned at a higher resolution. 

 
 
Question: What if  UN-SCAN-IT gel  gives inaccurate results? 
 
Answer(s): 
 
• Make sure the gel was scanned straight. 
• Minimize the number of stray marks on the gel. 
• Adjust the contrast setting on the scanner to give a more representative 

image. 
  
Note:  There are inherent uncertainties regarding the conversion of any image 

into data. UN-SCAN-IT gel and all gel analysis software simply make the 
best approximation for each image by converting the grayscale pixel 
values into meaningful quantitative data. The experience and expertise of 
the scientist is a crucial factor in obtaining accurate results from any gel 
analysis software package. 

 
Question: Why would UN-SCAN-IT gel indicate a screen driver or 
monitor problem? 
 
Answer: 
 
• UN-SCAN-IT gel requires that Windows be able to display at least 256 

shades or gray in order to analyze gels. Most monitors and graphics cards 
can accomplish this, however, the Windows Settings on your computer 
may only be set for a 16 color display. If you need assistance changing 
your color setting for your computer, please refer to your Windows 
Manual or contact customer support. 
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Question: What if the gel to be analyzed is on film or transparency? 
 
Answer(s): 
 
• Use a scanner that is designed for scanning transparencies or obtain a 

transparency adapter for your scanner. Scanning in transparency mode 
will allow light to transmit through the film, rather than simply being 
reflected. 

 
• If a transparency scanner is not available, place a clean white piece of 

paper behind the film so the reflected light from the scanner can most 
closely approximate the original. 

 
 
Question: What if the original gel is only visible under fluorescent light? 
 
Answer: 
 
• Take a photo of the fluorescent gel, and scan the film or photo (or use a 

digital camera to obtain the image). 
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 Appendix C 
 
 TROUBLESHOOTING FAQS (GRAPH DIGITIZING) 
 
 
Overview 
 
This appendix provides some possible solutions to questions that may be 
encountered while using the UN-SCAN-IT gel software to digitize (x,y) 
graphs. Please do not struggle with any technical issues that you may have 
regarding the use of this software, as we can often answer your question and 
solve your problems based upon our experience. Please note that the customer 
support information listed below can also be displayed from within the 
software by accessing the main Help menu. 
 
 
Customer Support: 
  Silk Scientific 
  1060 Oakmont Lane  Provo, Utah 84604 USA 
  Tel: 1-801-377-6978   Fax: 1-801-228-2448 
  E-Mail: info@silkscientific.com  
 
 
Question: Is there a way to get the image to load and digitize faster? 
 
Answer(s): 
 
•  Try scanning and saving the image at a lower dpi (dots per inch) 

resolution from within your scanning software. 
•  If you are loading the image file from a disk, copy the file to the hard 

drive, and load the image file from the hard drive. 
• Move the software onto a faster computer with more memory. 
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Question: What could prevent UN-SCAN-IT gel from reading the image? 
 
Answer(s): 
 
• Make sure you are loading the image file from the Digitize menu and not 

the File/Load menu. 
• Make sure the file was saved in a standard scanner format accepted by 

UN-SCAN-IT gel (e.g. .jpg, .tif, .bmp, etc.). 
• Try reading the image file on a different computer to make sure that it is 

not a hardware problem unique to your computer. 
 
 
Question: Does UN-SCAN-IT gel analyze PDF files? 
 
Answer: 
 
• UN-SCAN-IT gel does not currently accept PDF files. PDF files often 
contain multiple pages, imbedded text, and variable dpi settings, which can 
present difficulties in extracting accurate and useful digitized data. PDF files 
should be converted to a standard image format (tif, jpg, bmp, png, etc) before 
loading into UN-SCAN-IT gel. 
  
 
Question: Why does the image appear stretched or distorted in the Main 
Window? 
 
Answer: 
 
• If the Stretch to Fit option was selected, the entire image is scaled to fit 

within the main digitizing window. Any stretching of the image is to 
allow the entire image to fit in the within the main window (this apparent 
stretching will not affect the digitized data). If you would like to reduce 
the stretching in the main window, you can either resize the 
UN-SCAN-IT gel main window to dimensions more similar to the 
original image, or select the Maintain Aspect Ratio option to preserve the 
original image width to height ratio when displaying the image in the 
main digitizing windows. 
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Question: What if the grid line is digitized rather than the data line? 
 
Answer(s): 
 
• During the scanning process try adjusting the contrast control on your 

scanner to ignore the grid lines but pick up the data line. 
• Use one of the grid line filters available within the digitizing setup menu. 
• Make a photocopy of the original graph, using the sensitivity adjustment 

of the photocopy machine to reduce the intensity of the grid lines. 
• Erase the grid lines on one side of the data line with your scanning 

software or other computer paintbrush program, and re-save the image. 
Then use the Surface of Line point assignment to follow only the surface 
of the data line. 

• Digitize the graph in Manual Mode so that you can guide the crosshair 
along the data line, and ignore the grid lines. 

 
 
Question: Why would UN-SCAN-IT gel not digitize data points near the 
axes lines? 
 
Answer(s): 
 
• Ensure that the vertical limits were properly and accurately defined at the 

beginning of the digitizing process. The defined values should extend 
beyond the lowest and highest data points being digitized. 

• Make sure the line trace does not approach too closely to the axes, and if 
it does, define the axes slightly further away from the line trace. 

• If there is a significant tilt to the graph that would result in the axes lines 
not being parallel to the sides of the image, re-scan the image and adjust 
the axes so that they are parallel to the sides of the paper. 

 
 

Appendix C:  Troubleshooting FAQs (Graph Digitizing)  115 



 

Question: What if UN-SCAN-IT gel follows the horizontal axis line? 
  
Answer(s): 
 
• During the setup process, define the vertical limits slightly above the 

lower horizontal axis line and slightly below the upper horizontal axis 
line. 

• If there is a significant tilt to the graph that would result in the axes lines 
not being parallel to the sides of the image, re-scan the image and adjust 
the axes so that they are parallel to the sides of the paper. 

 
 
Question: What if UN-SCAN-IT gel gives inaccurate results? 
 
Answer(s): 
 
• Carefully and accurately define the axes locations and values during the 

setup process. 
• Confirm that the original graph is on a continuous linear or logarithmic 

scale and accurately plotted.  
• Ensure that there are no stray marks near or crossing the data line being 

digitized. 
 
Note:  There are inherent uncertainties regarding the conversion of any 
graphic image into data. UN-SCAN-IT gel (and all (x,y) digitizing software) 
simply makes the best approximation for each image by converting the pixel 
locations into meaningful quantitative data. The experience and expertise of 
the scientist is a crucial factor in obtaining accurate results from any digitizing 
software package. 
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Question: What if UN-SCAN-IT gel reduces peak heights when 
digitizing? 
 
Answer(s) 
 
• If the graph has sharp peaks, do not use the Both Surfaces (Mid-Line) 

point assignment. Surface of Line point assignment is far superior for 
graphs that contain sharp peaks. 

• If the graph has upward peaks, then make sure you selected Upper 
Surface of Line (and conversely for downward peaks). 

 
 
Question: Can the graph be digitized if the original is on paper too large 
to fit the scanner? 
 
Answer(s): 
 
• Photo-reduce the original to a size that can be easily scanned. 
• Scan only the portion of the paper that contains the graphical image. 
• Scan the image in pieces, and later append the digitized data points. It is 

crucial that each piece scanned contain proper scaling marks if the data is 
to be properly digitized and appended. 

 
 
Question: How can additional data points be digitized when the data 
memory is full? 
 
Answer(s): 
 
• Save the data that have already been digitized using the Save Data 

feature from the File menu. Then clear the data from memory using the 
Clear Data feature from the File menu. Resume digitizing by selecting 
Return to Current Image option from the Digitize menu. 

• Collect the digitized data at a lower resolution. 
• Scan the original graph at a lower dpi resolution. 
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Question: What can be done if UN-SCAN-IT gel gets lost? 
 
Answer(s): 
 
• Re-define the single pixel Data Line Color that you wish to digitize. 
• Erase grid lines or other stray marks that may cross the data line. 
• If the software is skipping to other data lines or marks, ensure that the 

data line of interest is a continuous curve. 
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 Appendix D 
 

NEW VERSION 7.1 FEATURES (GEL ANALYSIS) 
 
  
Overview 
 
This appendix provides a brief overview of some of the new gel analysis 
features of UN-SCAN-IT gel Version 7.1. Most of these features are 
described in further detail in the body of this manual. 
 
Scalable Main Image View 
The main image view can be set to maintain the aspect ratio of the original 
image. This eliminates the undesirable stretching that sometimes occurred 
when the original image is stretched to fit the digitizing screen.  
 
Zoomable Main Image View 
When the main image view is set to maintain aspect ratio, the image view 
zoom level can be selected as 1x, 2x, 4x, 8x and 100% values. This allows a 
closer inspection of the positioning of the lane or segment boxes. Note: 
Analysis may be slower while the image is zoomed. 
 
Distance Measuring Tool 
This new tool may be used to measure distance on the image in the 
horizontal (x), vertical (y), and combined (z) directions. Simply click the 
mouse at the point where you wish to begin the measurement, and drag the 
mouse cursor to any point on the image. The data can be displayed in 
pixels, inches, or centimeters. 
 
Gaussian Peak Resolving 
The software may miss peaks, find extra peaks, or not resolve overlapping 
peaks. The Resolve Peaks feature can be used to overlay Gaussian peaks on 
the density profile to estimate where the baseline should be set if the peaks 
were represented by a Normal distribution. The three Gaussian peaks in the 
upper left corner of the density profile can be used to overlay the peaks you 
wish to fit. You can use one, two, or all three of the Gaussian peaks to fit 
single, double, or triple peaks. 
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New Context Sensitive Help Buttons and Tooltips 
Context sensitive help button are now located adjacent to many of the setup 
and analysis options. In addition, descriptive tooltips are displayed when the 
mouse moves over the controls and icons. 
 
Turbo Mode 
A new digitizing speed setting (Turbo Mode) is available that allows the 
image to be digitized extremely quickly. Turbo mode does not display the gel 
digitizing process as the image is being digitized. This option can be used 
when maximum digitizing speed is required.  
 
Additional Image Formats and Larger Image Support 
The software supports additional gel image formats, and can load images 
larger than the previous 32000 x 32000 limit. 
 
New Peak Finding Options 
Additional options for user defined automatic peak finding settings are 
available in the density profile screen.  
 
Band Normalization Tool 
The Pixel Total values for all segments can be Normalized to a user defined 
segment by clicking the Normalize button above the results grid.  
 
Enhanced (x,y) Graph Digitizing Features 
UN-SCAN-IT gel also contains enhanced features for digitizing (x,y) 
graphical images. The features are described in the appendix that follows.
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 Appendix E 
 

NEW VERSION 7.1 FEATURES (GRAPH DIGITIZING) 
 
  
Overview 
 
This appendix provides a brief overview of some of the new features of 
UN-SCAN-IT gel Version 7.1. Most of these features are described in further 
detail in the body of this manual. 
 
Scalable Main Image View 
The main image view can be set to maintain the aspect ratio of the original 
image. This eliminates the undesirable stretching that sometimes occurred 
when the original image is stretched to fit the digitizing screen.  
 
Zoomable Main Image View 
When the main image view is set to maintain aspect ratio, the image view 
zoom level can be selected as 1x, 2x, 4x, 8x and 100% values. This allows a 
closer inspection of the positioning of the setup icons, and also provides a 
more detailed view of the positions of the digitized data points. Note: 
Automatic Digitizing may be slower while the image is zoomed. 
 
Integrated Digitizing and Graphing Screens 
It is now possible to go directly from the digitizing screen to the graphing 
screen, and also to return directly from the graphing screen to the digitizing 
screen. This feature allows the addition, deletion, modification, and display of 
the digitized data values between the digitizing and graphing screens to be 
virtually seamless. 
 
Toolbar Shortcuts 
Many of the most common menu selections from the UN-SCAN-IT gel 
menus can now be accessed more easily using the toolbars located below the 
menus. Some of the toolbar options include shortcuts to the digitizing screen, 
graphing screen, pause button, speed settings, zoom settings, help menus, line 
types, and data copying and saving features. 
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Integrated Digitizing and Graphing Spreadsheets 
Both the digitizing screen and the graphing screen contain spreadsheets that 
display the (x,y) data values in real time. These spreadsheets can be useful in 
tracking and modifying the (x,y) data values during the digitizing and 
graphing process. 
 
Turbo Mode 
A new digitizing speed setting (Turbo Mode) is available that allows data 
points to be digitized extremely quickly (30,000+ points per second). Turbo 
mode does not display the crosshair movement, digitized data points, or the 
data spreadsheet as the points are being digitized. This mode is useful when 
maximum digitizing speed is required and no user interaction will occur. 
 
Increased Number of Data Points 
The maximum number of digitized (x,y) data points has been increased to 
100,000 data points per file. 
 
Vertical Data Shifter 
A graphical data shifter tool has been integrated in the digitizing screen to 
allow selected digitized data points to be shifted up or down to better fit the 
graphical image.  
 
Additional Image Formats and Larger Image Support 
The software supports additional graphic image formats, and can load images 
larger than the previous 32000 x 32000 limit. 
 
New Context Sensitive Help Buttons and Tooltips 
Context sensitive help button are now located adjacent to many of the setup 
and digitizing options. In addition, descriptive tooltips are displayed when the 
mouse moves over the controls and icons.  
 
Larger Setup Icons 
The digitizing setup icons are larger and clearer to improve user interaction 
during the setup process.  
 
Customizable Data Eraser 
The size of both the data eraser and data shifter can now be customized to 
improve precision. 
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Improved Graphing Features 
The graphing screen now includes new line types, improved X data spacing 
adjustment, additional screen colors, and smooth point sizes. 
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Glossary 
 
1-bit Image - This type of image contains only a single pixel color, and is used 

to represent line drawings. This format is also referred to as Line Art or 
Black & White.  

 
8-bit Grayscale Image - This type of image contains 8 bits per pixel, and 

represents each pixel with one of 256 shades of gray. This format is also 
referred to as Black & White Photo. 

 
24-bit Color Image - This type of image contains 24 bits per pixel, and 

represents each pixel with one of 16,777,216 colors. 
  
ASCII (text) - ASCII format is a universal data format used by most 

computers for data and text exchange. UN-SCAN-IT gel can export data 
in both tab and comma delimited ASCII (text) format. 

 
Background - The background for most gels is the average pixel intensity for 

a region where no bands are present. The non-zero background can present 
a problem when quantifying segments, as pixel sums become dependent 
upon the size and shape of the segment box. This background interference 
can be reduced or eliminated by using one of the UN-SCAN-IT gel 
background subtraction methods or the the Calibrate Image Intensity 
feature during the gel setup procedure. 

 
Black & White Image - This type of image contains only a single pixel color, 

and is used to represent line drawings. This format is also referred to as 
1-bit or Line Art.  

 
Clipboard - Both Windows and Macintosh computers have a temporary 

location in memory where data or graphics can be placed. This Clipboard 
region can be used to transfer data between programs. UN-SCAN-IT gel 
can export data to the computer’s Clipboard, and the data can be pasted 
into other applications. 

 
Colored Line - Most scanners and image input devices represent colored lines 

by a mixture of pixels of varying colors. UN-SCAN-IT gel uses a color 
approximation algorithm to digitize colored data lines and points. 
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Contiguous Data Point – A data point that is comprised of a set of contiguous 

(i.e. touching each other) pixels of a defined data color. 
  
Data Eraser - A graphical eraser box used in the digitizing or graphing screen 

to delete underlying data points from memory. 
  
Digitizing Process - The process of converting raw pixel locations and 

intensities into useful scientific data. 
 
dpi - Dots per inch (dpi) resolution of an image. Digitizing a 10 inch long 

graph that was scanned at 300 dots per inch will produce approximately 
3,000 data points in line follow mode. 

 
Image Input Device - Any device (such as a scanner or digital camera) that 

will capture a hard copy image and convert that image into a useable 
computer format (e.g. jpg, tif, .bmp, etc.). 

 
Image Stretching – When Stretch to Fit option is selected for the main image 

view, the entire image will be stretched to fit within the main digitizing 
window. Although the digitizing results will not be affected, it is often 
preferable to select the Maintain Aspect Ratio option to preserve the 
original image width to height ratio when displaying the image in the 
main digitizing windows. 

 
Full Scanner Resolution - The image will be digitized at full scanner 

resolution, and is not limited to screen resolution. Therefore, scanning the 
image at a higher dpi setting can improve the resolution and accuracy of 
the digitized data (i.e. digitizing a 10 inch long graph that was scanned at 
300 dots per inch will produce approximately 3,000 data points). 

 
File Types (Data) - UN-SCAN-IT gel can export data in both tab delimited 

and comma delimited ASCII (text) format. This format can be imported 
into nearly all spreadsheet and data analysis programs. In addition, the 
data can be saved to the computer’s Clipboard and pasted into these 
applications. 

 
File Types (Image) - There are a number of commonly used image file types 
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supported by nearly all scanners and digital cameras. UN-SCAN-IT gel 
can import and digitize most of these common file types such as JPG, 
TIFF, PNG, GIF, and BMP. 

 
Grayscale Intensity Width – A user defined range for the grayscale values 

that UN-SCAN-IT gel will accept as data. 
 
Horizontal/Vertical Range – A user defined range for the grid line filter 

window used to ignore grid lines during grid line filtering digitizing.  
 
Line Art Image - This type of image contains only a single pixel color, and is 

used to represent line drawings. This format is also referred to as 1-bit or 
Black & White. 

 
Line Following Algorithm - The method that UN-SCAN-IT gel uses to 

follow and assign an (x,y) data value to each point along the curve. This 
method involves many considerations, such as line thickness, tilted 
graphs, intersecting curves, grid lines, etc. 

 
Resolution - Although the resolution (number of pixels in each step) can be 

adjusted in the Options portion of the software, UN-SCAN-IT gel 
generally operates at a resolution of one scanner unit. Therefore, 
digitizing a 10 inch long graph that was scanned at 300 dots per inch will 
produce approximately 3,000 data points. The digitized data resolution can 
be further adjusted using the Adjust X Data Spacing option in the 
graphing screen. 

 
Single Valued – A curve or function that has only a single y value for each x 

value along the curve. Circular graphs, drawings, etc. are not single valued. 
 
TLC Plate - The UN-SCAN-IT gel software can also be used to digitize TLC 

(thin layer chromatography) plates, and is not limited to just 
electrophoresis gels. If the TLC plate is fluorescent, you will need to scan 
a photo of the plate, or use a digital camera. 

 
Vertical Data Shifter - A graphical data shifter box used in the digitizing 

screen used to shift the selected digitized points vertically. 
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X Data Spacing - The (x,y) values of the digitized data are extracted 
directly from the pixel locations on the original image. Although the x 
values may have what appear to be arbitrarily assigned x spacing, due 
to the conversion of a pixel location to an (x,y) value, the spacing can 
be Adjusted to any user defined increment. The Adjust X Data 
Spacing feature (located in the Graphing portion of the 
UN-SCAN-IT gel software) is useful for aligning x spacing in order to 
graph multiple curves on the same scale using other graphing software 
or to set x data points to exact user specified values. 
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